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OUR GUARANTEE

This product carries the unconditional guarantee of satisfaction or your
money back. Any product may be returned to place of purchase for com-
plete refund or replacement within thirty (30) days of purchase if accompa-
nied by the sales receipt or other proof of purchase.

RADIO FREQUENCY INTERFERENCE STATEMENT

This equipment generates and uses radio frequency energy and if not
installed and used properly, that is, in strict accordance with the
manufacturer's instructions, may cause interference to radio and television
reception. It has been type tested and found to comply with the limits for a
CLASS B computing device in accordance with the specifications in
Subpart J of Part 15 of FCC Rules, which are designed to provide reason-
able protection against such interference in a residential installation, How-
ever, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause interference to radio or television
reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of
the following measures:

+ Reorient the receiving antenna.

= Relocate the computer with respect to the receiver.

* Move the computer away from the receiver,

* Plug the computer into a different outlet %o that the computer and receiver

are on different branch circuits.

If necessary, the user should consult the dealer or an experienced radio/
television technician for additional suggestions. The user may find the
following booklet prepared by the Federal Communications Commission
helpful:

"How to Identify and Resolve Radio-TV Interference Problems."

This booklet is available from the U.S. Government Printing Office, Wash-
ington, D.C. 20402 Stock No. 004-000-00345-4.

Customer Licensing Agreement

The Roger Wagner Publishing, Inc. software product that you have just re-
ceived from Roger Wagner Publishing, Inc., or one of its authorized deal-
ers, is provided to you subject to the Terms and Conditions of the Software
Customer Licensing Agreement. Should you decide that you cannot accept
these Terms and Conditions, then you must return your product with all
documentation and this License marked "REFUSED" within the 30 day ex-
amination period following the receipt of the product

1. License. Roger Wagner Publishing, Inc. hereby grants you upon your
receipt of this product, a nonexclusive license to use the enclosed Roger
Wagner Publishing, Inc. product subject to the terms and restrictions set
forth in this License Agreement.

2. Copyright. This software product, and its documentation, is copyrighted
by Roger Wagner Publishing, Inc., with all rights reserved. You may not
copy or otherwise reproduce the product or any part of it except as ex-
pressly permitted in this License.

3. Restrictions on Use and Transfer. The original and any backup copies of
this product are intended for your personal use in connection with no more
than two compuiers used by you. You may not sell or ransfer copies of, or
any part of, this product, nor rent or lease to others without the express wril-
ten permission of Roger Wagner Publishing, Inc. You may make backup
copies of the software for your own ose only.

4. Use of authored software: "Stacks". Using HyperStudio, you can create
hypermedia applications for use by yourself and others, called "stacks".
You may distribute the stacks in any way you wish, including, but not lim-
ited 1o, both commercially and as public domain. You may not, however,
distribute copies of HyperStudio itself to any third party.

5. Examples: If, for example, you have a computer at both home and work
that are personally used by you, you may use the HyperStudio software on
both machines. If you only use one computer, you may not, however, give
a copy of the software 10 another person for their own use. In a school or
office setting where there are several computers being used simultaneously
by different people, a site license from Roger Wagner Publishing, Inc.
would be required, if individual copies had not been purchased for all those
using the sofiware,




Limitations of Warranties and Liability

Roger Wagner Publishing, Inc. and the program authors shall have no
liability or responsibility to purchaser or any other person or entity with
respect to liability, loss or damage caused or alleged to be caused directly or
indirectly by this software, including, but not limited to any interruption of
service, loss of business or anticipatory profits or consequential damages
resulting from the use or operation of this software. Some states do not
allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion

may not apply 1o you.

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER
EXPRESS OR IMPLIED, REGARDING THE ENCLOSED COMPUTER
SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS
FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS
WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS.
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH
VARY FROM STATE TO STATE.

The HyperStudio documentation and software are copyrighted ©1989 by
Roger Wagner Publishing, Inc., all rights are reserved. This documentation
and/or software, or any part thereof, may not be reproduced in any form or
by any means, electronic or mechanical, including photocopying, recording,
storage in an information retrieval system, or otherwise, without the prior
written permission of the publisher.

Apple, Apple [IGS, AppleWorks, GSOS, and HyperCard are trademarks of Apple Computer
Ca,, Inc.
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HyperStudio Introduction

Introduction to HyperStudio

Welcome to the world of HyperStudio and hypermedia! HyperStudio provides you with the
complete system to create things on your computer that will make it more useful, more educa-
tional, and just plain more fun than you can probably imagine.

What is Hypermedia?

If you're new to the subject, it's probably in order to answer the question "What is hyper-
media?” You're already familiar with the various ways of exchanging information that
currently exist. Newspapers, books, movies - all these are referred to as the media, and are
those channels that handle the mass distribution of information. In addition, the term media
also refers to the specific physical form that carries the information. This can be the printed
word, a colorful artistic graphic, or an electronic image. However, for the most part, all of the
current ways of conveying information in the modem world are passive. That is, you act as a
silent viewer of the information presented.

The word "hyper” is derived from a Greek word meaning extreme or beyond. The word
hypermedia was coined to describe a way of communicating that went beyond the current
notions of the media.

Imagine starting with something commonplace, like a book. This is a typical form that infor-
mation in our world takes, Now imagine seeing not only text and pictures on each page of the
book, but certain areas that you could touch with your finger that would suddenly expand into
a whole new page of information, or that would perhaps instantly take you to an entirely
different part of the book, perhaps even to a completely different book. While you're thinking
of that, wouldn't it be nice if the pictures on the page could actually be animated to show a bird
flying, or the path that an army during the Civil War followed? Better still, imagine hearing
the sounds of the battle while you read the text!

Well, imagine no more, because this is exactly what hypermedia offers, and in particular, what
HyperStudio delivers! In the coming chapters of this manuel, you'll start by looking at some
sample Hyperstudio applications ("stacks"), and then move into a tutorial of how to use the
tools provided in the HyperSwudio package to create your own stacks. HyperStudio also gives
you the tools to take existing HyperStudio stacks, and to enhance and change them as you
wish. You'll find it's easy to take an existing HyperSiudio application, and to use it as the
starting point for an entirely new application of your own.

What HyperStudio Can Do For You

Al this point, the relevance of hypermedia to your own sitivation may not be obvious, so let's
look at some specific ways that HyperStudio may be of immediate use to you.
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When you made your decision 10 buy the Apple IIGS, you were probably attracted Lo its
terrific graphics, realistic sound abilities, and overall power of the system. Al the same time,
the Apple IIGS is one of the easiest-lo-use computers every created.

You've probably seen programs that take advantage of many of these features on the Apple
1IGS, but found it difficult o find something that combines them all in one environment.
HyperStudio's first big feature is that it gives you one environment where you can use all the
abilities of the Apple IIGS in a wide variety of applications, or in creating your own.

This brings us to HyperStudio's second big use: creating your own software programs on the
computer, without having to spend a lot of time, or needing a lot of technical knowledge.

If your family has young children leaming the alphabet, the names of states, or other skills,
you could try to buy a program that teaches these concepts. Chances are, however, that it
would be relatively expensive, take time to find, and might not even be readily available.

With HyperStudio, it's easy to create a few screens with letters of the alphabet, or words and
common objects, even a map of the Unitied States, and add your own voice prompting to click
on the right image or state. Best of all, the whole family can participate in creating this kind of
software, helping with voice prompts and responses, creating graphics, recording sound
effects.

However, HyperStudio isn't just for creating software for young children. What it is good at is
communicating ideas and information. If you're a teacher, this can be lessons, presentations,
even lests on many kinds of material. From foreign languages to complex concepts, Hyper-
Stdio is the perfect tool, and requires no more effort than preparing any other kind of a lesson
presentation.

If you're a student, HyperStudio offers the most dynamic environment for reports ever created.
It can also be used to record and organize notes and ideas for the more traditional written
report.

Even if you are neither teacher nor student, but would like to share knowledge you have with
others, record your family tree, introduce customers lnyombwmssmuwpmdmmnrshnw
them how to find something their locking for, keep track of your music or magazine
collection, or any number of other applications that hypermedia is an idea solution for, then
HyperStudio is for you.

The HyperStudio disks come with many example stacks to get your started, and give you ideas
for your own stacks. For now, though, let's get started by making a backup of the HyperStudio
disks, and then looking at some HyperStudio applications that we have included in the
package.
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Backing Up Your HyperStudio Disks...

Although the chances of physically damaging a disk in normal daily use are fairly small, it is
still a good idea to make a duplicate copy, or "backup disk", of the original disks provided in
IheHypm'Smdnpmi:age This process is very easy, takes only a few minutes, and is a very
worihwhile "insurance” provision for the possibility that something does ever happen to the
disks you use on a daily basis.

So, before proceeding further, take a moment now to make backup copies of the HyperStudio
disks. You can do this with the Finder software provided with your Apple IIGS (on the Apple
System Disk) as you would any other 3.5" disk, or you can use your own disk copy utilities, as
you prefer. Do make sure that the names of your final backup disks are the same as the
originals, i.e., /HyperStudio, /HS.Demo, /HS.Art, and /HS.Sounds. The Finder can be used to
rename disks, if necessary.

Since there is not much space remaining on the HyperStudio disks for additional files, we
recommend you make a data disk for the stacks you create. The Finder on the Apple Sysiem
Disk will also format new disks for you. You can name this disk HS.Data if you wish,

If you are unsure of how to make backup copies, or create data disks, see the manual "Apple
NIGS System Utilities”, that came with your computer,

After making your backup copies and a new data disk, continue with the next section.

System Requirements

HyperStudio {equi:ts an Apple IIGS with at least 1Mb total RAM, and a 3.5" disk drive. It is
compatible with GSOS, and can be run on hard disks, as well as the Appleshare Network.

While working through the examples on the Home Card, and the tutorial, we recommend you
set your RAM disk to 0K (zero K), using the RAM disk option in the Control Panel. This
will give HyperStudio access to all of the RAM in your computer for the various stacks.

The memory requirements for any particular stack depend entirely on the individual
characieristics of the stack you create, That is, depending on how many different
backgrounds, graphic objects, and imbedded sounds you use for a stack, the memory used by
the stack can vary over quile a range. With no imbedded sounds, and simple card
ha:_kg!'ounds your stack could have hundreds of cards in it. HyperStudio is designed to
oplimize memory usage by compressing memory, and other techniques.

Digitized sound require approximately 10K of RAM per second of sound. Thus, a 10-second
sound would require 100K of memory. However, HyperStudio does not require that every
sound in a given smckbeloadedaltmnhesameum and in practice, the amount of sound
available in a stack is more a function of disk size.

Pagef
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Installing the Hardware

Pant of the HyperStudio package is a set of sound digitizing (recording) equipment. These
tools are provided to make it as easy as possible to not only enjoy the excellent sound quality
of HyperSwdio applications, but to also allow you to easily record your own voice, music, and
sound effects for hypermedia applications that you create yourself.

Before proceeding, verify that the following components are in the box:

= (1) HyperStudio digitizing board.
= (2) bolts, and (2) nuts.
= (1) microphone with stand.

You'll also need a small flat-bladed screwdriver, to tighten the bolts on the digitizing card.

Installation of these components in your computer is very easy, and is comparable to attaching
any common interface card, such as a hard disk controller card.

Installation Steps

1) Turn off the computer.

2) Remove the cover to the computer itself by gently pressing down on each plastic tab at the
back of the computer. While the tabs are depressed, use the palms of your hands to lift the
back of the cover up, and remove,

3) Looking down at the computer, with the front closest to you, you'll see seven "slots” to-
wards the back of the computer, and one more to the far right, and closer to the front.

The good news is that the HyperStudio digitizer doesn't go in any of these slots. This has two
immediate benefits. First, your recordings will have much less background noise than record-
ings done with many alternative boards that do have to go in a slot. This is because the com-
puter itself is the source of background "hiss" or occasional "pops”, and this electronic noise is
strongest in the slot connectors. Second, there are a limited number of slots in your computer,
and those users who are quickly filling them up will appreciate the fact that the HyperStudio
digitizer doesn't require any of this valuable “real estate.”

4) To install the recording hardware, first insert the bolt through the lower hole in the mounting
bracket of the circuit board. Insert the bolt so that the head is on the side of the plate opposite
the circuit board, and the threaded end points towards the board. Now attach the nut to the
bolt, but do not rn the nut more than 3-4 wms. You want there to be a lot of open area left
between the nut and the head of the bolt. (See fig. 1)
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5) Looking at the back of the computer, you will see that there are openings ("cutouts") in the
back panel, which are closed off with plastic covers. On the interior side of the back panel,
these covers are attached with a metal clip. Identify the opening at the far left (closest to the
power supply), and wrn the clip counter-clockwise one-half turn. The clip should now be
easily removable by gently pulling it directly towards the front of the computer, at which point
the plastic cover will also fall free.

6) It is behind this opening, inside the computer, that you will mount the circuit board. Pre-
pare now by making sure that you have located the second mounting bolt, and nut, but do not
attach them to the board yet.

7) Before inserting the board, remove any interface card, such as a printer card, that may be
present in slot #1 (the slot closest to the power supply).

8) The power for the digitizing card is picked up from two small wire posts near the back of
the computer, and which are marked "fan”. These posts are usually used for powering an
internal cooling fan in the computer. If you have an internal fan, disconnect it now from the
power connector. (See figure 2)

L
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9) Locate the small two-wire connector coming from the digitizing card, and push it onto the
post marked "fan" near the back of the computer. The plug is "keyed" which means that it is
very difficult o install backwards. However, just to be sure, verify that the red wire is on your
left, as you look towards the back of the computer, with the front of the computer closest to
you.

10) If you have an internal fan, you can now attach its connector to the 2-pin connector on the
digitizing board. This replaces the function of the connector on the computer's main circuit
board, and can be used for anything that would otherwise require the connector used by the
HyperStudio digitizer card.

11) With the lower bolt and nut as loose as they can be without the nut falling off, pull the head
of the bolt away from the bracket. With the 7-pin connector on the right side of the board, and
facing up, place the board and its mounting bracket against the inside back of the computer so
that the loose bolt drops into the notch at the bottom of the cutout. The idea here is to fit the
card into position with the head of the bolt on the outside of the back of the computer,

12) Once in position, gently tighten the bolt and nut with your fingers. DO NOT TIGHTEN
COMPLETELY! You will want to leave a little "slack” for the moment so that you can insert
and tighten the upper bolt. It may be necessary to gently push down on, or fold to the right, the
wires that go from the power supply to the computer's main circuit board to make room for the
digitizer card.

NOTE: Although the first opening (from the left) in the back of the computer is generally the
most convenient location for the HyperStudio digitizer, there are also three other possible
positions that you can use. Use of these will probably require that the slot in front of the cutout
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does not have an interface card in it, but you are welcome to use whatever cutout is the most
convenient for you.

13) Now insert the bolt though the top hole in the back of the computer and the mounting
bracket on the card. Anach the nut to the end of the bolt on the inside. Ii is a little cramped
here, but with patience you should be able to get it in place. It works best if you work on
turning the head of the bolt with the screwdriver, rather than the nut. Aren't you glad you set
up the lower bolt before putting it in the computer?

If you drop the nut while trying to attach it to the bolt, don't panic. You can just lift out the
digitizer board, retrieve the nut, and then replace the board and try again. If your screwdriver is
magnetized, it will be a lot easier to pick up the nut by just touching the end of the screwdriver
o it

ALTERNATE INSTALLATION TECHNIQUE: If you find that trying to thread the top
bolt after placing the digitizer card in place is too difficult, you can try this altemnate approach.

Before trying to put the board in the computer, partially thread both nuts onto each bolt, both
top and bottom, leaving as much free play in the bolt as possible. Now, lower the head of the
lower bolt into its slot in the cutout, and use the tip of your finger, or the screwdriver, to push
the head of the top bolt down as you pass it through the cutout. Once the heads of both bolts
are through the cutout, adjust them into the proper position in each slot, and tighten with the
screwdriver. (See figure 3)

Upper Bolt
B aits

uaikor Slotted bolt-hole in
j\ back-pane| cutouts

—_
(Side View) W L

Lower Bolt
Peosition

Figure 3
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14) Once the nut is threaded onto the bolt, tighten both the top and bottom bolts, DO NOT H
OVERTIGHTEN! It is not necessary to turn the bolt head until it absolutely won't budge. It is Spemal Features Note

only necessary 1o make sure that the connecting bolts are firm. ; B o . .
.4 g The microphone connector on the HyperStudio digitizing card has a special convenience

15) If you have removed a printer interface card, or any cards from the other slots, you can feature built into it that you should know about

now replace them. The microphone connection has a switching function. When the microphone is plugged in, the
16)Now et h it boar s mound, i h -pin conmector tvirds e ot of A e s e e,

computer, and on the right side. It is marked "J25", and is right next to the connector for the
speaker. If you already have another sound-related hardware device in your computer, such as
the MDIdeas or FutureSound cards, unplug their connector from this post.

customary way. This makes it easy to switch between the HyperStudio digitizer, and an
alternate device.

: R . The sound output function of any device (stereo card, etc.) connected to the HyperStudio
17) Now plug the long ribbon cable that comes from the HyperStudio digitizer into the 7-pin o Ea : : fin i ot . ;
connector on the computer's main circuit board. It is also "keyed” so that connecting it im- digitizer is always active, regardicss of whether or i - plrgget

properly is very difficult. However, you should verify that the red wire on the ribbon cable is
closest to the front of the computer as it enters the connector at J25. The cable is deliberately
made just long enough to reach the J25 connector, so as to reduce electrical noise. If you have
a lot of extra cards in the slots of your computer, run the ribbon cable over the tops of all of
them, rather than trying to snake the cable between cards.

18) If you have disconnected an existing sound hardware device, you can now plug it into the
replacement connector at the top of the HyperStudio circuit board.

19) The installation of the board itself is now done. Before putting the cover back on the
computer, you should take one last look around inside 1o meke sure that everything has been
properly attached, and that there are no loose wires left hanging. Once you have checked, you
can then put the cover back onto the computer.

20) The microphone is plugged into the connector on the mounting plate for the HyperStudio
digitizer, and is generally placed on the left side of the computer.

That's it! The HyperStudio hardware is now installed. Should you need to move your com-
puter, simply unplug the speaker and microphone from the back of the computer. It should not
ever be necessary to remove the circuit board, although you may want to check the tightness of
the connecting bolts occasionally if you move your computer often.
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HyperStudio: A Quick Look

The best way to see what HyperStudio can do is to look at some of the demonstration files
provided as part of the package. This will give you a sense of where you're headed in the
tutorial section as you construct the sample hypermedia applications, and will also give you
some good ideas as you start your own creations.

To begin, just start up your Apple IGS with the main HyperStudio disk (/Hyperstudio). This
will load GSOS (the GS Operating System), HyperStudio, and also automatically load a stack.

The stack loaded is rather special, and is called the Home Stack. The screen that first comes
up is called the Home Card. The Home Card is a central reference point from which you can
launch other stacks or application programs. When finished, the stacks you use, or the applica-
tion programs you launch, will return back to the Home Card.

On the Home Card you'll se¢ a number of small graphic pictures, called icons. These represent
the stacks and applications that you can get to from the Home Card. When you move the
mouse, you'll see that the cursor is a small hand. By positioning the hand over the item you
want, and clicking the mouse, you can select which stack or application you want to use.

Some of the Home Card items will be explained later, but there are a few that you'll want to
know about now.

First, the Sound Shop, Sight 'n Sound, and Browser icons are for launching separate programs
provided on the HyperStudio disk.

Sound Shop is a dedicated sound recording and editing utility. Sight 'n Sound lets you put a
startup picture and sound on a disk, and Browser lets you quickly scan a disk with recorded
sounds. All three of these are described later in this manual, and it's best to leave them for the
time being, while you explore HyperStudio.

The remaining icons are all used to access existing stacks on the HyperStudio disks. When
you click on any of these, if the disk that is needed for the loading of that particular stack is not
in memory, HyperStudio will prompt you to insert the needed disk.

You could experiment by just clicking on the various icons, but for now, let's start with the
stack called Intro. The Intro stack is located on the disk labeled /HS.Demo. If you have two
3.5" disk drives, insert the HS.Demo disk in the second drive. If you only have one 3.5" drive,
remove the HyperStudio disk, and insert the HS.Demo disk.

Position the mouse cursor over the icon labeled Intro, and click the mouse. There will be a
pause while this stack is loaded from the HS.Demo disk, after which the screen will fade to the
opening card of the Intro stack.

Page 10 s
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The "Intro" Stack

This stack is an introduction to HyperSwdio and the elements that make up a stack, Tt will
give you an idea of the various objects that can be on a given card in a stack, and also what
actions can be done by pressing a button. Use the mouse to click on butions as directed. At the
end of the Intro stack, you'll be returned to the main Home Card on the HyperStudio disk.

The important things to notice in moving through the cards that make up this stack are, first,
how easy it is for a user to move through a hypermedia presentation. Hypermedia is also
sometimes called "interactive multimedia.”

Second, you'll notice that with just a few simple building blocks, a wide variety of software
applications are possible. Although the Intro stack does not attempt to show all the possible
applications itself, it should be quickly evident how powerful a tool HyperStudio can be, and
all without requiring any programming knowledge, and with & minimum investment of time.
When you return (o the Home Card, you can explore other example stacks that have been
provided.

Other Stacks

After viewing the Intro stack, and learning about the various elements that make up a card and
its stack, try exploring the other stacks provided on the HS.Demo, HS.Art, and HS.Sounds
disks. These stacks are already connected 1o the Home Card. When you click on an icon in the
Home Card, you will be prompied to insert the proper disk.

If you have installed the HyperStudio software on your hard disk, the Home Card will work
best if you put all the stacks from the various HyperStudio disks in the same folder on our hard
disk,

Following is a brief description of each of the other sample stacks. Afier browsing through the
existing stacks, continue with the next section, "Using HyperStudio”.
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Demonstration Stacks:

Button Ideas: This stack has a collection of graphic images that can be used as buttons on a
card. To use a graphic as a button, use the Get Clip-art function in the File menu of
HyperStudio. After pasting it onto your card, you simply define an "invisible button” that
overlays the graphic image. For more details, see the section on invisible buttons later in this
manual.

Card Ideas: This stack concentrates more on the possible layouts of cards, rather than particu-
lar applications. Remember, you can always use the images and cards from any of the stacks
on this disk as the starting point for your own stacks.

Jukebox: This stack plays a collection of music and sound effects on the HS.Sounds disk.
Saturday: This is an example of how a young child could use HyperStudio to tell a story.
Spanish: An example of a foreign-language lesson created with HyperSmdio.

Family: A geneology stack that you can use as the basis for your own family tree.

Art Library: This is a "slide show" of some of the clipart provided on the HS.Art disk. When
your run this stack, you will be prompted 1o insert the disk "HS.An", If necessary, you can
remove either the HyperStudio or the HS.Demo disk to insent the HS.Ar disk.

This also demonstrates the use of one of HyperStudio's extended features, the "User-defined
Button Action”, in the form of a stack that sequentially loads and displays whatever Super Hi-
Res pictures are in the same directory as this stack. The user-defined button action is a "hook”
into HyperStudio that lets assembly-language (or Pascal, or other language) programmers add
their own special functions o HyperStudio.

Testing Stack. This stack shows how HyperStudio can be used to give a test, and displays the
results of the file created by the test stack.

Read and Listen. This is a limited version of a stack from the Manchester Apple Users’
Group, which was created to reinforce word recognition for early reading skills.

Video Overlay Demo. If you have the Apple I1 Video Overlay Card and a Pioneer 4200
LaserDisc player, be sure io look at this stack. If you only have the Video Overlay Card, but
not the Pioneer 4200, use the Open Stack function in the File menu, and look in the folder
Video, inside the Xcmds folder, on the HS.Demo disk. There you'll find an altemate demon-
stration stack that can be used with live video sources like video cameras, VCRs, eic.
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Other Stacks: As time goes on, and space on the disk permit, some stacks may be added to
the Home Card that are not described here. It is also possible that some stacks listed above
may have been deleted in the interest of presenting a more useful example of another kind.
However, you should find all the stacks on the disk sufficiently self-explanatory.

Sources of Other Stacks

It is not necessary to create your own stacks to find HyperStudio a useful addition to your
computer. Many user groups, schools, and modem-accessed bulletin board sysiems have
public-domain stacks that are readily available. In addition, commercial software publishers
also will no doubt offer many different types of stacks to HyperStudio users.

Roger Wagner Publishing, Inc. is planning a catalog of available stacks, and this is a good
reason (o retumn the Software Registration Card at the front of this manual. By letting us know
where you are, we'll also be able to send you that catalog of available stacks.

The final source of HyperStudio stacks, and we think one of the most rewarding, is to simply
create them yourself. “Authoring” a HyperSmdio application is very easy, and the resulting
stack can be distribuied to others with no license fee required. The Software License at the
front of this manual gives you permission to distribute stacks in any way you wish, as long as
the HyperStudio software itself is not passed on to others.

To see how easy creating a stack can be, read on to the next section,
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Creating Your Own Stacks:
HyperStudio Applications

By now we hope that you have explored the stacks that are presented as examples on the
HyperStudio Home Card. This section will lead you through an introduction on how to create
your own stacks. [It's actually quite easy, and we hope you'll be inspired to use your Apple
NIGS computer to the best use imaginable - as a personal computer for use by yourself and
others in the communication of the information and ideas that are of interest o you.

We like to think of HyperStudio as a tool for "disktop publishing”. You may have already
heard of "desktop publishing." That's where you use your computer to do the layout and
printing of a newsletter, brochure, perhaps even an entire book. However, when you're done
using all your great computer tools, what you end up with is the same thing that Gutenburg
did: Sheets of paper with ink on them. To get your ideas duplicated, you'll still need to goto a
pﬁl:nu-,md in the case of a book, spend perhaps thousands of dollars to share your ideas with
others.

Once they get the book, your readers will be forced by the medium - the book itself - to go
through your ideas in a lincar fashion. That is, they'll start on page 1, and finish on page 599,
or wherever. They won't have the option 1o suddenly jump ahead to find out more about a
certain part that interesis them. In addition, if your subject is something not easily explained in
a straight-line path, you'll have to force your ideas into the traditional form anyway. That is, if
you don't have HyperStudio.

With HyperStudio, you can now put subjects as diverse as your family tree, or everything you
know about gardening, onto a disk. If the person using your stack wants to jump from one
Place o another because the ideas are connected, they simply click on a bution you've added,
which then takes them to that part of the stack. When you've finished your stack, you don't
need to go to anyone to duplicate the information. For the cost of a single disk, you can
distribute the information to anyone you want. No minimum printing quantities, no special
equipment needed. Just copy your disk, and you've entered th= age of hypermedia, and disktop
publishing.

We believe that there are two immediate benefits (o every computer user as a result of this
process. First, more than ever before, a method is provided for an individual 1o record, organ-
ize, and distribute their ideas, without requiring that there be a "mass market” for their work, or
requiring the "approval” and financial cooperation of a large publisher.

Secondly, in the area of computer software, we think you'll finally see a wider range of afford-
able software. For most programs, including HyperStudio, a remendous amount of effort goes
into the development of the sofiware itself, independent of the information content. In the case
of educational software, for example, this means that most companies spend much more time
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and money on the part of the software that puts an image on the screen, than they do the actual
information content.

With HyperSwdio, virtually all the time invested in creating a new software product can be
put into the information in a stack, rather than the "core” routines necessary to display the
information. This means that it will be possible 10 create better software in less time, and to
you that means more software at a smaller cost

Well, enough discussion. Let's dig in and see just what's involved in creating a new stack.

Creating a Stack: A Simple Example

Any stack is nothing more than a series of cards, on which are placed various objects. These
objects can include:

= Text
* Graphics

* Butions

= Sounds

+ Video sequences

The buttons are used 1 move between cards, or to trigger cenain actions like the playing of a
sound or an animation sequence.

The steps to creating a stack are fairly simple:

1) Choose New Stack from the File menu.

2) Create a series of cards with the desired backgrounds.

3) Add information to each card in the way of text and graphics.

4) Add buuons to move between cards, or trigger actions on a card.

That's it! Since cards can be added anywhere in a stack, moved from one position to another,
deleted, copied, and in general manipulated in many ways by the computer, you can use the
computer itself to help you organize your thoughts. In general, you'll get off to a better start if
you try 1o conceptualize your project as well as you can before beginning, but HyperStudio is
flexible enough to let you change things as you go along.

For our first stack, let's suppose you wanted to create a stack like the "Spanish” stack, that
teaches a foreign language,

Step 1: Go 1o the File menu in HyperStudio and choose New Stack. Of course, if you
haven't started up the HyperStudio disk, you'll need to do this first! When the Home Card

v
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appears, Jjust choose New Stack. It won't hurt anything as you see the screen clear to a blank
white card. The system has now been cleared of the existing stack, and is ready for you to
begin.

Don't worry about the Home Card. It's still on the HyperStudio disk. Choosing New Stack
only affects what is in the computer's memory, not what is on the disk.

Step 2: Prepare the cards and their backgrounds. For our example stack, we'll start with a
map of the world as the first card. The next card will be a scene of a plaza, with various things
typical of a foreign location - a passport, room keys, taxi, etc. In this background, we've even
included a guitarist and dancer!

a. To load the first background, go to the File menu again, and choose Load Background.
The standard file selection box will appear. If the disk HS.Ant is not already in the disk
drive, insert it now, and click on Disk (or press the Tab key) to show the list of files on the
disk. If you have several disk drives, it may be necessary o use the Disk button several
times to finally list the HS.Art disk.

When the list of pictures on the HS.An disk is displayed, use the scroll bar controls, or the
arrow keys on your keyboard, to scroll down until you see the file "World.Map" high-
lighted. As a short-cut, you can also press the "W" key.

When the file World.Map is highlighted, press Return, or click on the Open button. You
can also just double-click on a file name to load it. The screen will then fill in with the
picture of the world map. This is the background for your first card.

b. Before adding anything to the first card, let's finish setting up the background for the
second card. Pull down the Edit menu, and choose New Card. The screen will erase
again as a new card is created, and the upper-right corner of the screen will now display
"Card 2",

¢. Now load the background for the second card by again choosing Load Background from
the File menu. This time load the picture file " Spanish.Pic", also located on the HS.Art
disk.

d. You have now created two cards, each with a unigue background. To move back (o the
first card, pull down the Move menu, and choose First Card. This will move you back to
the first card, which has the picture of the world map.

Step 3: Now you can add some objects to the first card. To begin with, we'll add a small box
of text that tells the the user what you expect them to do. To do that, go to the Objects menu,
and choose Add a Text Item. This is used 10 add a body of text, as an object, to a card. It's
called an object, because when you come back to the card you can move the block of text
around, edit the text, delete it, and do other actions, independent of the graphics background on

|
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the card itself. This is in contrast, for example, to the paint tools text entry, where once you
type something on the card, it becomes a permanent part of the background. More on that
later, however.

a. The first ime you add text, a dialog box will appear reminding you that the box you are
typing in can be moved and resized as desired, and that when you're finished entering text
you should click outside the text box. Click on the Continue button once you've read the
message. This box only appears once in any given time that you use HyperStudio.

Next, a rectangle will appear, that represents the area that you want the text to appear in
on your card. By puiting the mouse on any comer of the rectangle, holding down the
mouse button, and then dragging the mouse, you can re-size the box to make it larger or
smaller. By putting the mouse on the frame or interior of the rectangle, you can use the
mouse o drag the box to a new position. For now, position the box in the upper right
corner of the world map, and then click the mouse anywhere outside the rectangle. This
tells HyperStudio that you are done positioning the rectangle, and to drop it in that
position.

b. Now, a dialog box will appear giving you a choice of styles for the text box, and also
asking you if you want to type text in now, or load a file from disk. Click on the check
boxes, if necessary, so that Draw Scroll Bar, Allow Scrolling, and Draw Rectangle
Around Text, are checked; Text is Read-Only should not be checked. Then click on
"Type Text Now." This will bring up the built-in word processor in HyperStudio, and let
you type in the window that you've defined.

¢. Type in the text: "The spanish language is spoken all over the world. Click on the
button for one of the countries for an example.”

Step 4: That's it for adding the text! Now let's add a button. Go back to the Objects menu,
and choose Add a Button.

a. The first screen that appears will present you with a selection of bution styles. Choose the
square button, with the small shadow, by clicking on it with the mouse., To add text
within the button, just type on the line provided. For this button, type "Mexico", and
press Return (or click on the "OK" bution).

b. The button will now appear in the upper-left corner of the world map, Use the mouse o
position the button just to the left of where Mexico is located on the world map, Click
outside of the button, anywhere on the world map. As with the text item, this "drops”
the button, and tells HyperStudio you're finished positioning the button.
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The next dialog box that appears is provided to let you choose what action should be taken
when the button is pressed. Under "Connect to:", is a list of possible "targets” that Hyper-
Swudio will move to when the button is pressed. Since we want this button to move to the
next card, the one with the Spanish scene, click on "Another Card", at the top of the
Connect To list.

The screen will now clear, and you'll see a dialog box that says "Move to the card which is
the target of this button, click OK when the proper card is displayed.” The idea here is to
use the commands in the Move menu to move (0 the card that you want. Choose Next
Card in the Move menu. You'll now see your Spanish scene. Now click on "OK" 1o tell
HyperStudio that this is where you want to move to when the button is pressed.

The next choice you get is what type of visual effect, or transition, you want when the user
moves 1o the new card. You've probably seen a number of these transitions by now, in the
example stacks of the Home Card. For this transition, choose "Fade to white", and click
on the "OK" button (or press Return). As you create your own stacks later, you'll want to
experiment with the different transitions to see how they look.

Once that's done, you're back at the Button Actions section. In addition to moving to
another card, you can still decide whether you want a test score kept ("Test functions™),
and whether a sound should be played, or an animation (when available) started. For now,
just click on "Done” (or press "Retun"),

You could use Next Card in the Move menu to move to the next card, but you can also just
use the button you defined. Click on the "Mexico” button to move to the Spanish scene,

On this card, we'll suppose that you want to set things up so that when the user clicks on
something in the scene (like the passport, taxi, eic.), they'l hear the Spanish word pro-
nounced. To do this, you'll want to put an invisible button over each image, and have the
button play a sound when pressed. An invisible button is used for those cases where you
want 1o define a graphic image, such as the Home Card Icon, or an arrow, or in this case,
the passport, as a button. It is also used for those cases where you don't want the user to
see where you're expecting them to click the mouse. An example of this was in the
"About Computers” example in the Intro stack, where you were asked to click on the disk
drive. (Look for this stack on the Home Card, if you haven't tried it already).

The first item in the picture we'll try will be for the passport, in the lower-right corner of
the screen. Since you're again adding a button, go to the Objects menu, and choose Add a
Button.

This time, choose Invisible button, and click on "OK" (or press Return). Now, instead of a
floating button, you'll see a twinkling rectangle, indicating the "hot" area for an invisible
button. Positioning and sizing this rectangle is done in the same way thai you worked
with the text rectangle. Use the mouse pointer to dfag the comers of the rectangle to
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resize it. If you hold down the mouse button and drag the mouse with the cursor inside
the rectangle, you can reposition the button wherever you want. This rectangle will define
where the user will be able 1o click with the mouse w0 get the same result as clicking on a
button.

J. Use the mouse to position (drag) the rectangle over the passport. Pressing the mouse
button down with the cursor in the middle of the rectangle, and dragging the mouse will
move the rectangle. Size the box to just fit around the passport.

k. As before, to tell HyperStudio you're finished with the rectangle, just click outside the
rectangle somewhere. You'll get the same dialog box of Button Actions as before. This
time, leave the "Connect To:" setting to "No Connection”, and click on "Play a sound...”.

. A new dialog box will appear that will give you the choice as to whether you want to
record the sound now, or use a Disk File. We've included a pre-recorded voice of the
spanish word for passport on the HS.Demo disk. Insert the HS.Demo disk in your disk
drive, and then click on Disk File to begin the loading process.

m. If the files on the HS.Demo disk are not already listed, click on the Disk button until they
are. Then press "P" to highlight the file "Passport.Span", and press Return (or click on
Open).

n. Aﬂuﬂwmundhnsbccnlmdeiapicmmof&lapemmrduwiﬂappw.ﬂislasm
play the sound to see if it is the one you wanL Click on the Play button on the tape
player to hear the sound. You can also use the volume control to adjust the volume to
your liking. Click on the "OK" button near the bottom of the screen when finished.

o. After telling HyperStudio what sound to use with this button, you'll be returned to the
Button Actions menu again. The dialog box should display "No Connection”, a check-
mark in "Play Sound", and "No Test Functions”. Click on Done.

p. The card will now reappear. If you now click on the passport, you should hear the
Spanish word for passport!

Trying It Out

To try your stack out, choose First Card in the Move menu. Then click on Mexico. When the
Spanish scene appears, click on the picture of the passport to hear the Spanish word.
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Saving Your Stack

Saving a stack is easy. Just choose Save Stack As from the File menu. Since there is not
much remaining room on the HyperStudio disks for new files, you'll have to save your stack on
your own data disk. If it is not already in a drive, insert your data disk (HS.Data if you've
created one as suggested earlier), and use the Disk command umtil you see the disk name in the
dialog box. For now, use the name My.Spanish. Once saved, you can run the stack again by
just re-loading the stack, using the Open Stack option in the File menu.

Adding it to the Home Card

Although you can now run your stack by loading it directly, let's see what's involved in adding
your stack to the Home Card itself. Basically, what is required is:

1) Create a graphic image on the Home Card.
2) Define an "invisible button” over the graphic that connects to your stack.
3) Save the modified Home Card Stack back to disk.

This process is very easy. To begin, your working copy of the HyperStudio disk should be in
your drive, Go the File menu and choose Open a Stack. Use the Disk button, if necessary, to
list the stacks on the HyperStudio disk, then load the Home.Stack.

Step 1: Although HyperStudio has built-in painting tools with which you can create a graphic
image, it also lets you use existing graphics that you may have from other Apple IIGS paint
programs, such as PaintWorks Gold™, 8/16 Paint™ , or others. HyperStudio also includes its
own extensive set of "clip-art” that you can use in creating your stacks. These graphics are
located on the disk labeled "HS.Art".

a. To use an existing graphic, you can use the Add Clip-art function, located in the File
menu. If the disk HS.Art is not already in one of your disk drives, insert the disk now, and
then choose Add Clip-art. If necessary, use the Disk button to list the graphic files on the
HyperStudio.Art disk. Select the file "Icons" (press "I" to jump to the file!), and click on
Open.

This file is a collection of graphic images like the Home Card Icon, arrows, and other
items you'll find handy. We'll use one of the graphics on this page as the icon for the
sample stack you just created. Look in the upper-right comer of the graphics page. In the
second row, you'll see two images of stacks of cards. Let's use one of these as the icon for
your stack.

b. Across the top of the Add Clip-an window are four icons that indicate what you can do
while in this window. The rectangle on the left is a selection tool that selects a square
chunk of graphics from the page. The lasso tool lets you draw a line around the graphic
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you want, and then copies just the graphic, leaving the white background behind. Since
you're copying the card icon 1o a colored (yellow) background, you'll need to use the
lasso.

Click on the lasso with the mouse. It will highlight, showing it is now the active tool.
Now use the mouse to draw a line all the way around the card icon. It's a rather tight
squeeze between each of the graphics, so you'll have to draw carefully. If you make a
mistake, and run into one of the other graphics, or accidentally hit part of the card, don't
worry. Just release the mouse button, and try again. When you have successfully circled
the card icon, the edges of the image should "shimmer", showing the image is selected.
Now use the mouse to click on the "OK" icon at the top of the clip-art window.

d. The clip-art window will disappear, and you'll see the image of the card icon floating over
the Home Card. Put the mouse pointer over the middle of the card image, and hold down
the mouse button while you move the mouse to position the card icon in one of the open
positions on the Home Card. When you get the icon where you want it, just let go of the
mouse button, and then click anywhere outside of the icon. The card icon will then be
"pasted” onto the Home Card image. (If later you decide to erase this image, you can
always use one of the paint tools, and paint, in yellow, over the image to erase it.

€. Last of all, you'll probably want to add a few words under the card icon to describe it. For
this you can use the painting tool's "text tool”. The painting text tool is different from the
"Add a Text Item" function in the Objects menu. When you add a text item, it is separate
from the background, and can be moved around and resized at a later time. The paint
tools directly alter the background graphic by "painting” what you do onto the back-
ground. For the Home Card, this makes more sense than creating a text item.

Use the mouse o select the Tools menu, and choose the Text tool. This is the icon that
looks like the letter "T" near the bottom of the menu. The mouse cursor will now change
to what is called an "insertion cursor”, indicating HyperStudio is ready to let you type text.

Before typing, you should also know that HyperStudio lets you type the text in any of the
allowable painting colors. The labels for the other icons on the Home Card are typed in
the dark red color, rather than black. Use the mouse to open the Options menu, and
choose Set Text Color. Choose the red color square, then click on Ok.

f. Now position the cursor under the card icon, and a little 1o the left of center, and click
the mouse. A blinking insertion point will now appear. Type the words "My Spanish".
You don't need to press Return. Now, look to see if the text is where you want it. If not,
you can use the backspace or Delete key to erase what you've typed, then move the mouse
cursor and click more to the left or right, or up or down, as needed. You signal that you're
finished creating text by either clicking the mouse again somewhere else on the screen, or
choosing another tool (like the browse tool) from the Tools menu.
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If you're still having trouble getting the text exactly where you want it, you can also just
type the words you want, without worrying if they're exactly where you want them. Then
£0 o the Tools menu, and select the dotted rectangle tool in the third row from the top.
Now position the mouse just a little to the left, and above, the words you've typed, then
press the mouse button and hold it down while you move the mouse to the right, and
down.

Use this motion to draw a box that completely contains your text. Then release the mouse
bution, and the rectangle will become a moving line, Now place the mouse in the middle
of the box (the cursor will change to an arrow). By holding down the mouse button, and
moving the mouse, you can "drag” the words to the exact position under the card icon that
you want. The closer the dotied-line box is to the text itself (that is, the smaller the box),
the easier it will be to get the text next to other graphics without erasing part of them.
When you've got the text where you want it, click outside of the box to finish placing it.

If you want to try drawing a differeni-sized box again, choose Undo from the Edit menu,
and try again. Until you actually drag the selected rectangle, you can also cancel a box
that's been drawn by just clicking outside the box.

Step 2: The next step is to create an invisible button over the card icon. You've already
created an invisible button in the earlier example, so this next part should be easy.

First, go to the Objects menu, and choose " Add a Button™, As before, choose the
"Invisible" button, and then position and size the rectangle so that it forms a box around
your card icon. You'll probably want it to include the text as well. Then click the mouse
outside the box to finish the placement.

The Bution Actions dialog box will then appear. This time, you want to "Connect to
Another Stack...". When you click on this, the Standard File Interface box will appear,
displaying only the stacks on your disks. If needed, insert the disk with your sample stack
saved on it (HS.Data if you've been following along), and select the file My.Spanish, and
press Return. The Standard File Interface dialog box will then disappear, and you'll be
allowed to select what transition effect you want used when your stack is started. Choose
whatever seems best to you. After clicking on OK (or pressing Return), you'll be returned
to the Button Actions screen. You could elect to have a sound played as you moved to the
new stack, but for now, just click on Done (or press Return).

Finally, you'll want to save the new Home Card stack back to your working copy of the
HyperStudio disk. Save this in the same way you saved the stack you created earlier.
Insert the HyperStudio disk (a backup, we hope!) into your disk drive, and then choose
Save Stack As from the File menu, and save the stack using the name Home Stack. If the
list of files for the HyperStudio disk doesn't appear immediately, click on the Disk button
to switch 1o the HyperSmdio disk.
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When you click on Save, a dialog box will appear remirding you that the stack
Home.Stack already exists on that disk. Click on Replace to continue the save process.

Special Note: In the interest of minimizing the number of times you have to switch disks,

the Home.Stack has been placed on both the HyperStudio and HS.Demo disks, The

Home.Stack on the HyperStudio disk is only used when your first start up the Hyper-

Studio disk. After that, control passes to the HS.Demo disk, and it is that copy of the

Home.5tack that is used from then on. If you want the My.Spanish icon to show up on the

g:::e.(:arﬂuall the time, you should save a copy of the new Home.Stack to the HS.Demo
as well.

If you are using HyperStudio on a hard disk, you would only have one copy of the
Home.5tack, presumably in the folder HyperStudio.

By the way, the difference between Save Stack As... and Save Stack is related simply to
whether you are saving a stack that HyperStudio already knows the name and location of,
or whether you are saving a stack for the first time (or giving it a new name and location).
When you begin a stack with "New Stack”, it has no name. To save it the first time, you

would use Save Stack As... to give it a name, and 10 choose the disk you want to save it
on.

However, once you've already saved the stack (or if you've loaded it earler from disk),
HyperStudio then kmwsthenamcandlocaﬁmofﬂtcsm:k,andymcanjmlmSm
Stack. This avoids having to re-type the name of the stack every time you want to save it.
If you want to save a current stack under a new name, or on a different disk than the one it
was last loaded from, or saved to, you can always use Save Stack As... again.

Step 3: Afier modifying the Home Card, you may also want to add the Home Card Icon to
your own stack so that users can easily return to the Home Card. This is basically just a matter
of doing the same thing you did to add an icon for your stack to the Home Card, but in reverse,
Inuﬁsmseynu'UuscmeAddClip-mfuncﬁnnmcopyﬂmHuncCardlmnﬁ-mrhelocm
file, and paste it onto each card of your own stack, (Or at least those where you want the user
10 have the option of retuming to the Home Card.)

a.

Load your stack (presumably named "My.Spanish") from your data disk (HS.Data). If
you're still on the Home Card, you can also just click on the My Spanish icon that you
added a little while ago!

While viewing the first card, the world map, choose "Add Clip-art" from the Edit menu.
Get the file Icons from the HS.Ant disk. If you're unsure of how to do this, review the
instructions given earlier about using the Add Clip-art function (or look in the Reference
section of this manual, later) when using the Icons file for the card icon that was added to
your Home Card.
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¢. Use the lasso tool to grab whichever Home Card Icon you prefer from the upper-right
comer of the graphics page. Click on OK.

d. Now use the mouse to position the Home Card image in the lower-left comner of the
world map background. Click outside the image to finishing placing it.

e. Now use "Add a Button" from the Objects menu, and use the Invisible bution option to
define an invisible button over the Home Card Icon.

f. Select "Connect to Another Stack..." in the Button Actions dialog box, and choose the
Home.Stack on the HyperSwdio disk as the destination for your button. Select a transi-
tion that you like, and click on OK. Finally, click on Done. (You may have to put the
HyperStudio disk back in the drive here).

Note: Whenever you finish adding a button, the mouse cursor changes 1o a hand. This is
called the "browse tool", and is required to click on buttons to make them do something.
The browse tool can be selected from the Tools menu whenever you want to use existing
buttons to move through your stack.

g. Now use the Move menu to move to your second card, the Spanish scene, and repeat
steps "b" through "f" 10 add a Home Card Icon button to that card as well.

(Do you have the feeling these instructions are becoming more brief? You're right! We're
forcing you to remember what you learned a litde earlier in the hopes that you'll soon be
self-sufficient! If you do forget how to do a cenain action, just go back a few pages until
you find the detailed explanation of how to do what you want. In addition, you can always
turn to the Reference section of this manual to read how to use any particular command.)

h. Finally, save your stack (My.Spanish), with the changes you just made back to your data
disk (HS.Data). You can use Save Stack in the File menu to do this.

Now you should be able 10 use your own Spanish stack from the Home Card whenever
you want!

Where to Go From Here?

You've now successfully gone through the basic steps to creating a stack. HyperStudio offers
many more options in adding information to cards, controlling what happens on each card, and
much more. Each available function is described in the Reference section that follows,

Because this information is presented more by function, rather than in a tutorial, you will find
that the best way to use the information is to first browse through the text to get an overview of
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what functions are available. Then, when creating your own stacks, you can refer back o just
those sections that are relevant to what you want to do.

HyperStudio is designed so that the manual is not absolutely required to perform the most-
common activities. However, there are advanced features that you will find this manual
helpful in understanding. In addition, there are other utilities provided on the HyperStudio
disk, such as Sound Shop, Sight 'n Sound, and Sound Browser, that are described after the
Reference section.

When in doubt, jump right in and EXPERIMENT! As long as you're using backup disks of the
HyperStudio software, you can't hurt anything by trying things. If you think a certain
combination of actions might be useful for what you want to do, just try it. HyperStudio has
been designed to be as intuitive as possible. If all else fails, however, feel free to call our
Technical Support department, weekdays (M-F), from 9:30 am. to 5:30 pm. (PST).

Page 25




Reference HyperStudio

HyperStudio Reference Section

This section describes each of the menu items in the HyperStudio authoring environment.

File Menu

This menu relates to the various file-, and thus, disk-relaled activities related 1o a stack, Many
commands in not only the File menu, but other functions of HyperStudio, will require your
identifying a file on a disk to load, or a name and location for the saving of a file. Virtually all
of these operations will be done with something called the Standard File Interface.

The Standard File Interface will appear whenever a file is loaded or saved, and it works by
presenting a dialog box with a list of various files on a disk, ard buttons with which 1o exam-
ine other disks and open folders. Finally, it determines a specific file to access by either your
clicking with the mouse on the filename you want to load, or your directly entering the name
to use for saving a file.

When the file interface is first presented, it always starts by showing the relevant files in the
directory in which the HyperStudio application was locaied. There are four buitons to the right
of the filename window. The Disk button shows you the main directory of any other disks that
are in other drives in your computer. If you want to put a different diskette in a drive that was
Jjust displayed, simply replace the diskette, and click on Disk. You can also press the TAB key
as an equivalent keyboard command for the Disk button.

If a file is highlighted, either by clicking on its name with the mouse, or by using the up and
down arrows, you can click on Open to load the file, or you can just press the Return key. If a
folder is selected (highlighted), then choosing Open will open that folder, and show the files
within that folder. As a convenience feature, if you press the letter keys on your keyboard, the
file selector will automatically go to the first file in the current list that begins with that letter.
From there, you can use the arrow keys to select a particular file.

If you are viewing the files in a folder, and wish to "back up” one level to the previous direc-
tory, click on the Close button. You can also press the Escape key.

Finally, if you should be presented with the file interface, and decide you want to cancel the
operation, simply click on the Cancel button. There is no keyboard equivalent for the Cancel
button.

When examining disks, note that not all files will always be displayed. If you are loading a
sound file, for example, only sound files and folders (subdirectories) will be shown in the
filename window. On the other hand, if you were loading a picture, only the graphics file-
names would be visible in the window. This is so that you do not have to look through unre-
lated files while searching out the one you want.
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When a file is saved, all the files in the current directory are shown in dimmed text. This is so
that you can see which filenames are already used when entering a new name.

New Stack: This option erases whatever stack is currently in memory, and begins a new one.
If you have not saved whatever is in memory since you last made a change, a dialog box will
appear asking you to confirm your request o start a new stack.

Open Stack: This is used to open a stack that already exists on the disk. This can be a stack
you created yourself, or it can be a stack created by another person. When this menu item is
chosen, you can indicale the stack you want to open using the Standard File Interface dialog
box that will be presented. Once loaded, a stack can either be directly used, or you can edit the
stack, adding or deleting more cards andfor objects as you wish.

Save Stack and Save Stack As..: These are used to save a copy of the current stack on a
disk. The very first time you save your stack, you'll have to give it a name, This is done using
the Save Stack As... command. Until a name is given the stack, the Save Stack command will
be disabled.

When Save Stack As... is chosen, the Standard File Interface is presented, but there are some
additional functions present, as compared to a Load command. The most important item is the
box at the bottom of the window where you should enter the name you want used when the
file is saved on your disk. A default name of "New.Stack" is presented, but you should enter
your own filename. The second new ilem in this dialog box is the button New Folder, just
below the Disk button. This lets you create your own file folders, while you're saving the stack
itself.

To create a new folder, enter the name of the folder you want to create in the edit-box at the
bottom of the window. Then click on New Folder. A new folder of that name will be created.
You can then open this folder up, and save your stack in it if you wish,

Once the computer knows the name of the stack in memory — either because you have used
Save Stack As..., or because you loaded an existing stack from a disk - the Save Stack menu
item can be used. When Save Stack is chosen, HyperStudio immediately saves a copy of the
current stack in memory to the disk using the current name.

Load Background: In HyperStudio, each card can be thought of as a background graphic
over which various objects are placed. Even a blank card has a background — a white one. On
each background can be placed graphics, text, or buttons. The background itself is generally a
common framework on which the objects on the various cards are presented.

For example, a stack which made up an address book might have a backgriund for each card
that looked like a file card. A stack could also have a background that suggested the pages of a
book. Backgrounds can contain graphics that add to the visual appeal of the cards, or the
background can be a solid color. Although some stacks you create or see w.ll probably have
one background for the entire stack, this is by no means a requirement, A stack can have as
many different backgrounds as you like,
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The Load Background command loads a 640-mode, Super Hi-Res picture, and uses that
graphic as the background for the current card. A background can be edited using the paint
tools (see the Tools menu). Whenever you create a new card (see New Card in the Edit menu),
HyperSwdio will automatically copy just the background of your current card onto the new
card. This is because, in many cases, you will want to repeat the same background on many
different cards. If you do want a different background when creating a new card, you can just
load a new background, or use the Erase Background (Edit menu) command.

HyperStudio does not actually duplicate the background when creating a new card, Instead, it
just uses the background from the one card for the others. That is, the same graphic is used
when displaying all the cards with that background. This has the advantage of using only a
fixed amount of memory (that used by the first background) for as many cards as you wish.
Whenever you load a new background, or draw on the current background with the paint tools,
HyperStudio turns this into a new background, and more memery is used to make room for the
new background. Solid color backgrounds use much less memory than complicated graphics.

When you are creating your stacks, try not 1o repeatedly load backgrounds, You will use far
less memory for your stack if you first load a single background, and then create all the cards
that use that background with the New Card command. Then create the cards that use a
different background. If you do have to switch between backgrounds as you create new cards,
iry 1o copy and paste existing cards, rather than loading new backgrounds.

Save Screen: Although you can use 8/16 Paint, Paintworks Gold, DeluxePaint II, Graphics
Studio, or virtually any 640-mode, Super Hi-Res drawing program o create backgrounds, you
can also use the built-in paint tools of HyperSwdio. The Save Screen command saves what-
ever is currently on the screen as a Super Hi-Res picture. Once saved, the image can then be
used as a background or graphic in other cards or stacks. Because the files are saved in a
standard format, you can also go back and forth between your favorite paint program and
HyperSwdio as often as you wish using the Load Background and Save Screen commands,
Screens can be saved with graphics, buttons, text, etc. either visible or not, as you wish. (See
Hide Items in the Options menu).

Add Clip-art: The HyperStudio.Art disk contains a number of useful graphic images that you
may find useful in creating your own stacks. In addition, you may have your own collection of
icons, button images, and small graphics that you would like 10 use on cards in your stacks.
The Add Clip-Ant function is provided as a way for you to copy a portion of a graphics screen,
and paste it onto the background of a card you are working on.

When you choose Add Clip-art, you will see the usual disk file interface. Use this to display
the file names of 640-mode graphic images that you have on disk. After selecting a file, a new
window will open displaying the graphic page.

Across the top of the Add Clip-art window are four icons that indicate what you can do while
in this window. The icon on the left is a selection tool that selects a square chunk of graphics
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from the page. The lasso tool lets you draw a line around the graphic you want, and then copies
just the graphic, leaving the white background behind.

If you make a mistake while selecting a graphic, and run into one of the other graphics, or
accidentally hit part of what you're trying to capture, don't worry. Just release the mouse
button, and try again. When you have successfully selected your image, use the mouse to click
on the "OK" icon at the top of the clip-art window.

The clip-art window will disappear, and you'll see the image floating in the middle of the
current card. Put the mouse pointer over the middle of the image, and hold down the mouse
button while you move the mouse to position the graphic where you want it. When you get the
graphic where you want it, just let go of the mouse button, and then click anywhere outside of
the image. The graphic will then be "pasted” onto the background.

Choose Printer: Use this to choose what type of printer HyperStudio will print to. The most
common setup is for an ImageWriter printer, using the Printer Port, with Direct Connect
highlighted. If you're not using AppleTalk, the User Name field isn't required.

Page Setup: This is used to specify other details about how you want HyperStudio to print
things. When you choose Page Setup, you can set which type of paper your printer is using;
whether things are printed vertically or horizontally on the page; print sizing; and whether to
reduce the printed image. The default settings are for standard US Letter size paper, Normal
vertical sizing and vertical printout. The printer effects check boxes are normally clear, with no
50% reduction and normal gaps berween pages.

Print: This is used when you want HyperStudio to print either the current card, all the cards in
the stack, or just the cards in the "back” list. When you choose Print, the first thing you'll be
asked is what card layout you want on each page, and what range of cards you want to print.
You have the choice of printing one card per page, or printing the cards full size (two cards per
page), or half-size (four cards per page). After choosing the layout, the standard print dialog
box appears, where you then choose how many copies you want. Ignore the options for which
cards you want to print, as this has already been selected in the first dialog box.

The printing process can be cancelled at any time, by pressing Apple-period during the print-
out.

Quit HyperStudio: Choosing this closes the current stack, and returns you to the Finder,
Program Launcher, DeskTop, ProSel, or whatever program launcher you used to start Hyper-
Studio.
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Edit Menu

This menu is used to cut, copy, and paste the objects on a particular card, parts of the back-
ground, or even entire cards,

Undo: This is used whenever you change your mind about certain editing actions. For ex-
ample, if you cut a button from a card, and then change your mind, you can choose Undo, and
the button will be put back as it was before the cut. If you paste a graphic onto the wrong card,
choosing Undo takes the graphic back off. Undo only reverses the very last action, and not all
actions can be undone.

Cut: An object (graphic, text or button) is cut by selecting the object with the edit tool (the
pointer - see the Tools menu), and then choosing Cut from the Edit menu. Once selected, you
can also press Apple-X on the keyboard to do a Cut. The Cut function removes the object from
the card, and places it on the elipboard. The clipboard is a term used to describe a lemporary
memory buffer where things are held while you decide what to do with them. The clipboard is
used with the Cut, Copy, and Paste commands to move objects from one card o another,

Once Cut, the object remains on the clipboard until you either quit HyperStudio, or until Cut
or Copy is chosen again from the menu.

In addition to objects, you can also cut portions of the background for pasting to another
location. Use the lasso and selector tools (Tools menu) 1o select the area to be cut, copied, or
cleared (erased).

Copy: Copy is identical to Cut, except that the original object is left in place, and a copy of
the object is placed on the clipboard. Pressing Apple-C is equivalent to choosing Copy from
the menu.

Backgrounds can be copied from one card to another, and this is the preferred way of using the
same on two different cards in those cases where the second card is not created
directly from the first.

Portions of the background can also be copied using the lasso and selector toals in the Tools
menu.

Paste: Choosing Paste from the Edit menu places a copy of the object on the clipboard onto
the current card. Once pasted, you can use the mouse to position the object, or portion of the
background, in the desired position. Clicking the mouse anywhere outside the pasted object
"drops” the item in the current position. Apple-V is the keyboard equivalent of the Pasie
command. When a card is pasted, it is always placed at the end of the current stack.
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Clear: This is used to delete an object without copying it to the clipboard. To delete an object,
simply click on it once with the edit wol (pointer - Tools menu). When the object is selected,
choose Clear from the Edit menu, or press the Clear (or Delete) key.

New Card: This is used each time you want to begin a new card in your stack. Each time New
Cardisselm‘led,mcbackgmundofmccm'mtca:ﬂisuﬂfmﬂnnewcnrd.ﬁnyobjectson
the current card are not copied.

Delete Card: This is used to remove a card from the stack. Note that this must be done with
some care, particularly in those cases where buttons on other cards in the stack are linked to the
card you are about 1o delete. Because this would leave those connections on other cards with
no destination, HyperStudio warns you if the card you are about to delete is pointed to by any
other cards. At that point, you'll have the choice of also deleting the buttons on other cards that
point to the card about 1o be deleted, or leaving them in place. If you leave them, and you
delete the card anyway, HyperStudio will mark those buttons as unaresolved, that is, they are
buttons that no longer have a destination.

Any visible button that is unresolved is indicated by being shown in red on a given card. This
is 10 make recognizing unresolved buttons easier. You can then go through your stack, and
easily recognize cards with unresolved buttons, editing the tuttons as necessary for the proper
operation of the stack.

Cut Card: This cuts the entire card to the clipboard, with the expectation that you will paste
the card into another stack, or perhaps at the end of the current stack. The card will remain on
the clipboard until you choose cut or copy again from the menu,

Lichlear,ifyoucmacardlhatispuinmdwbymhercmﬂs.anddunmpamci:backinmihn
stack, any unresolved buttons will thereafter be displayed in red.

Copy Card: This is identical to the Cut Card function, except that the selected card is not

deleted from the stack. The two immediate consequences of this are that, first, there is no need

to worry about unresolved butions on other cards, since the original card remains. Second, the

cczfdim cafe:rlf pasted, is not pointed to by any existing butions, since it will be given a new
number.

Erase Background: This erases the current background to one of the 16 colors on the
HyperStudio palette. See Set Background Colors, in the Options menu.
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Move Menu

This menu makes it easy to move around in a HyperStudio stack. The commands are as
follows:

Back: Selecting this takes you back, one card at a time, through the last 16 cards viewed.
This makes it easy to return to a card you viewed recently. This is different than the Previous
Card choice below. Back goes back through the cards in the order you viewed them; Previous
goes 1o the card that is physically in front of the current card.

Home: The Home Card is a significant point in the HyperStudio system. It is a "home base”
from which different stacks, and even applications, can be used. When you quit a given stack
or application, HyperStudio will always return to the Home Card.

Many stacks also have Home Card icons on various cards. Clicking on the Home Card icon
also returns you to the Home Card.

First Card: Choosing this takes you to the first card in the current stack.

Previous Card: This takes you to the previous card in the current stack. If you are already on
the first card in the stack, choosing this takes you to the last card in the stack. This is called a
"wrap-around” effect. Note that both Previous and Next Card functions go to the card specified
in terms of its position in the stack, not the order the user viewed the cards.

Next Card: This takes you to the next card in the current stack. If you are already on the last
card in the stack, choosing this takes you to the first card in the stack.

Last Card: Choosing this takes you to the last card in the stack.

Find...: Choosing this opens a window in which you can type a word or phrase. When you
press Return, HyperStudio will search through all the text items in that stack for the search
word(s). Note that HyperStudio searches from the current card forward. If you want to search
the stack from the beginning, be sure to remember to move 1o the first card before beginning
your search.

When you do your search, you will have the option of searching just the changeable or fixed
text fields on each card. You can also choose 1o search both. The difference in these types of
fields is described in the section on the text item tool.

Once the search has begun, you can search to the next occurence by pressing Shift-Apple-F.
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Tools Menu

The tools menu is an icon-based menu with two major groups of tools. The upper group of
icons represent major editing tools for screen itlems such as the text, graphics, and button
objects. The remaining tools are all paint tools, used when editing the graphics that make up
the curremt background.

Browse (hand): While editing a stack, you may want to click on a bution to verify its action,
or 1o move to another card. Selecting this tool gives a hand icon that is used 1o activate a
button. This is the default tool when HyperSwmdio is started up, and the Home Stack is loaded.

Button: This is used to highlight invisible buttons for editing, and to move or resize both
visible and invisible buttons. When you choose the button tool, all invisible buttons will be
shown surrounded by rectangles. You can then use the button tool to click on a particular
button to select it for dragging to a new position, or a cut, copy, or delete action. Selected
buttons can be resized by dragging the comers of the bution.

When a button is selected, you can choose Item Info in the Objects menu to get a description of
the button, or to edit the button name and appearance if you wish.

Edit Tool (pointer): This tool is a combination of all the specific edit wols (button, graphic
and text) used to select items for editing. Once selected, the item can be moved, edited, cut,
copied or deleted. Once a given item is selected, you can also use the Item Info function in the
Object menu for information about that object.

In general, the editing rules are as follows:

To Re-Position an Ohject: First, click on the item to select it. Then, put the cursor over
an item, hold down the mouse button and drag the mouse to
move the object to the new position. For buttons and text
objects, the object can be resized by dragging the comers of
the rectangle of the object. Clicking anywhere outside the
window places the object in its current position, and dese-
lects the object.

To Edit an Object: When an object has been selected by clicking once on it, it

can then be cut, copied, or deleted with the appropriate

option in the Edit menu.

If you want to edit particular attributes of the object, such as
the name and appearance of a particular button, etc., you
can select it with the edit tool, and then choose Item Info in
the Objects menu, and make related choices from there,
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Picture Tool: Choosing this icon will activate the tool that will let you edit all the graphic
objects on the current card. You can use the picture tool to click once on a particular graphic
item to select it for resizing, dragging to a new position, or a cut, copy, or delete action.

If you select the Item Info dialog box for the graphic (see the description of Item Info in the
Objects menu), you can change the border type using the same dialog boxes and controls as
were used when the graphic item was first added to the card.

Sound Tool: This icon shows a speaker, and is used to highlight all those invisible buttons on
the current card that have a sound attached to them.

After all the invisible buttons with sounds have been highlighted, clicking once on any of them
selects that button for dragging, or cut, copy or delete actions. Choosing the Item Info dialog
box for a bution (see the description of Item Info in the Objects menu), lets you can view and
edit the button name and appearance.

Text Tool: Choose this to display all text items on the current card. Use the Text ool to click
on a particular item to select it for resizing, dragging, or a cut, copy, or delete action.

If you want to edit the text in a text item, use the browse tool, and click on the item. When
using the Text tool, you can choose Item Info in the Objects menu if you want to make
changes o the overall appearance of the text item, or change whether it is a fixed or
changeable text block. Note that disk-based (extended) text objects are always read-only.

Paint Tools

The remaining tools in the Tools menu are used for editing the background graphic image.
Although the images in graphic objects cannot be edited directly, you can load any 640-mode
Super Hi-Res screen as a background, edit it with the paint tools, and then save the screen.
These saved images can then be used as either a background or a graphic item.

The paint tools are as follows:

Selector Tool: This is used to select a rectangular area on the screen to be cut, copied, or
moved by dragging. When the selector tool is active, the cursor changes to a cross-hair. An
area is selected by pressing the mouse button, and then dragging the mouse with the button
held down. As you move the mouse, a rectangle will indicate the area to be selected. When
you release the mouse bution, a blinking dotted line shows the selecied area. You can then
choose Cut or Copy from the Edit menu. Cut and Copy each put the graphic image on the
clipboard, after which it can be pasted on the current card, or any other card in the stack. If Cut
is used, the selected area is replaced by whatever color is under the upper-left comer of the
rectangle.
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If you want to move the selected area, simply move the mouse inside the rectangle. The cursor
will change to an arrow. Then hold down the mouse button while you drag the mouse, When
you release the mouse button, the image will be placed at that location. The area underneath
lhcglm:vedmmgleisreplacedbywhamercahrisunderlhc upper-left corner of the rec-
Lan

If you change your mind about the area you have selected, clicking the mouse once outside the
selected area removes the selection box. You can also click inside the selected area to deselect
it, but you must be careful not o move the mouse as you click the button, otherwise the region
may be moved as well.

Lasso: This is similar 1o the Selector tool, but is used to outline an image on a solid-colored
background. After selecting the lasso tool, you draw a free-hand line around the object to be
selected. When you release the mouse button, the color under the cursor when you started the
ln.&misuwdasthcbackgruundcolm,andmlypnmufmeh'uagcdiffermt&nmﬂmback-
ground are selected with an outline.

Once selected, the item can be Cut, Copied, or moved, just as you would with the Selector tool.

Pencil: The pencil is a fine-line drawing (ool that draws a free-hand line in whatever the
currently selected color is. The current color is chosen from the Colors menu, With this and the
other drawing tools, if you change your mind after drawing a line, just choose Undo in the Edit
menu. You can only undo the very last drawing action.

Paintbrush: This tool is like the pencil, but it can draw a variety of line widths. The brush can
also have different shapes, which can be used to produce different effects.

The brush shape is chosen with the Brush Shapes item in the Options menu. The current brush
color is set using the Colors menu.

Eraser: This is a handy way (0 erase an area of the screen. It is really equivalent to drawing
with a rectangular brush using the color currently set by the Set Background Color option in
the Options menu,

Linel'rnul: This is used to draw straight lines in the current color. Lines are drawn by just
pressing the mouse button at the point where you want the line to begin, dragging the mouse to
draw the line, and then releasing the mouse button where you want the line to end. Notice that
while the mouse button is down, you can reposition the end of the line anywhere you want
until the mouse button is released.

The width of the lines being drawn can be changed using the Line Size function in the Options
menu.
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Spraypaint Brush: This tool paints a scattered pattern of dots in the current color. By moving
the pattern over an existing image, you can create variations in shades, or just add interest to
the overall pattern.

Rectangle: This draws a rectangle in the current color, with a border of the current line width.
Press the mouse button to start drawing, and release the button when the rectangle is the
desired size.

You can also draw a solid rectangle by choosing the Draw Filled item in the Options menu.
When this is active, there is a checkmark next to the menu item, and the rectangle tool will
draw solid rectangles in the current color.

Rounded Rectangle: This is identical to the rectangle tool, except that the rectangle drawn
has rounded corners. As with the rectangle tool, the shape is drawn using the current color and
line width. If Draw Filled is active, a solid shape is drawn.

Fill: The tool icon for this represents a paint can pouring paint. This is used to fill an enclosed
region with a solid color. The active part of the fill-cursor is the very tip of the black area on
the cursor that represents the paint pouring out. The fill also uses the current color. The main
thing to be careful of when using the fill tool is to make sure that there are no "leaks” in the
area you are about to fill. However, in the event the fill does cover a larger area than you
intended, you can choose Undo to restore the original image.

Oval: This is similar to the rectangle tool, except that it draws an oval shape in the current
color and line width. When you first press the mouse button, that point represents the upper
left comer of an imaginary rectangle that contains the oval being drawn. The point at which
you release the mouse button represents the lower right comer. If you want a solid oval, use
the Draw Filled item in the Options menu.

Freehand Shape: This tool draws a closed free-hand shape using the current color and line
width. When you release the mouse button, a final line will be drawn from the end point to the
starting point, if you have not already closed the curve. If you want a solid shape, use the Draw
Filled item in the Options menu.

Text: This is used to add text to the background image. This is not the same as adding a rext
item! A text item is an independent object that can be moved and edited at any time. The
painting text wol, on the other hand, simply prints the text you type on the screen, at which
point it becomes part of the background.

When you choose the text tool, the cursor changes to an I-shaped cursor. To type lext, position
the cursor where you want 1o start typing at, and click the mouse once. The positioning cursor
will then disappear, and you'll see an insertion-cursor at the point where you are typing.
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The color of the text is controlled by the choice set in the Set Text Color function in the
Options menu. This will generally look best if the color is simply black or white, but will also
depend on the background color as well. While you are typing, you can use the Text Style item
in the Options menu to change the type style of the text that is being entered. However, once
you click the mouse in a new location, or choose another paint twol, the text will be merged
into the background image, and can no longer be changed. Note: When typing text on a
background that is neither black nor white, larger text sizes (see the Text Styles... choice in the
Options menu) will produce better results.

Magnifying Glass: This is a special mode for magnifying the image within a given area on
the background, and allows you to edit the screen dots pixel-by-pixel. This is also sometimes
called either a "fatbits” or "zoom" mode.

When you first select this item, a rectangle will appear on the screen that represents the area to
be magnified. Use the mouse to position the rectangle over the area you want to examine, and
then click the mouse button. You will then see a magnified image, with a normal view of the
same ared in the upper left comer of the screen. The paint tool at that point is the pencil, and
you can re-draw any point you wish in the current color.

You can use the Colors menu to change colors. You can also "pick up” a color from the current
magnified view by holding down the Apple key, and clicking on the new color. While you are
in the magnified mode, if you want to scroll the screen, you can hold down the Option key.
The cursor will change to a hand, and dragging the mouse will move the magnified image in
the same direction as the mouse movement.

Using any other paint tool, or clicking the mouse in the normal view window will exit the
magnified mode, and return you to a normal view.

If you have used the magnified mode once already, then selecting it again will automatically
start the selecting rectangle at the old position, although you can still move it to a new position
with the mouse if you wish.

Polygon: This functions lets you draw a closed polygon shape, using the current color and line
width. When you release the mouse button, it will complete the shape by drawing a final line
from the end point to the starting point, if necessary. If you want a solid shape, use the Draw
Filled item in the Options menu.,
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Objects Menu

This menu is used to add and edit objects on a given card. Ii also provides information about
the memory used by the current background, card, stack, and a given object.

Item Info: To use this, first select an object on the current card, using either a specific tool
(like the buttons, text, or graphic tool), or the edit tool (the pointer). Then choose Item Info
from the Objects menu. Depending on the actual item you have selected, the information
reported will be:

Button Info: This reports the name of the button. Even invisible butions can be given names.
Whatever text is entered on the edit-line when the button is created is used for the button
name. Names are not only used for visible buttons, but are written out to the disk as part of the
HS.Test.Results file for both visible and invisible butions, if the given stack is a test function
stack. The dialog box also provides an easy way of changing the button style.

There is also an entry for "Button ID", The value for Button ID is a number used by
HyperStudio to keep track of all the buttons in a given stack. It is provided for reference only,
and it is unlikely that you will ever need to use iL

Buttons actions cannot be directly edited (since redefining the actions would take just as long
as creating a new one); to change a button action, use the Button tool to select and delete a
button. Then create a new button to do what you want.

Text Info: This dialog box tells you whether a text field is scrollable or not, whether a scroll
bar will be drawn for the text item, whether the text is read-only (not changeable by the user),
and whether a frame will be drawn around the text item. Which features you use will depend
on the nature of a given text item. For example, if you were creating single-line entries, such
as an address book, eic., you would want each field 1o be non-scrolling, without scroll bars or a
frame.

Graphics Info: This reports whether a given graphic item is embedded or disk-based, how
much memory it uses, and lets you change the border size.

Card Info: When this is chosen, a dialog box appears that identifies the position of the
current card in the siack, how many buttons, sounds and graphics are on that card, and how
much memory is used by that card. The memory-required value is to the nearest 1K, and may
read "0" if the card uses less than 1000 bytes of memory.

Background Info: This displays a dialog box that shows how much memory within the stack
the current background uses, and how many cards in the stack use that background. Note that
backgrounds are always contained within the stack itself. When the background is stored in the
siack, it is compressed to minimize the amount of memory required.
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Also, when a new stack is created, the background memory use will read 32K until the next
card is created, or the stack is saved. Once compressed, Background Info will display the
correct value,

Stack Info: This displays a dialog box that provides information about the entire stack.
Information shown includes the size of the stack itself in memory, how many backgrounds are
used by the stack, how many cards are in the stack, and other useful facts.

Bring Forward: Use this when two objects overlap, and you want the selected item to be on
"top". Not all objects can be arbitrarily stacked. For example, text items are always "in front"
of graphic items. Items of the same type can be adjusted relative to one another.

Send Behind: Use this when two objects overlap, and you want the selected item to be on
"the bottom".

Adding Objects to a Card

Add a Button: Choosing this menu item tells HyperStudio that you want to add a new button
to the current card. When chosen, you'll be shown a dialog box that lets you choose from
among different button designs. At the bottom of the dialog box is a line with a blinking
cursor. This is where you can enter any text that you want displayed within a visible button
when it is displayed on the screen. If you don't want any text on the button, just leave this field
blank. After you have chosen the button style you want, click on OK.

Thcﬁrs:limeLhmynuaddabumn.HyperSnﬂiowi[lrerrﬂndymtoposiﬁmthcbumn.and
then click outside the button when done. Click on "Continue” after reading this dialog box.
Youcanuszlhcmousemdrsgmcblmmlowhﬂmvcrlocaﬁnnmﬂncardywwish.m

you have placed the button where you want it, click anywhere outside of the button to "drop" it
at the current position.

If you have selected the "Invisible" button, you'll get a dotied line rectangle indicating the "hot
area” for that button. Use the mouse to position the rectangle over whatever portion of the
screen you want to act as a button. You might, for example, put a rectangle over a picture of an
armow o use as a button, When positioned, click anywhere outside of the rectangle. You can
resize the button area by dragging any of the comers.

Button Actions: When you have positioned either the standard or invisible buttons, the next
step is 1o specify what action you want taken when the button is activated. A dialog box will
appear that has two major groups:

Connect To... This allows you to specify where to branch to when the button is activated. The
choices are:
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* Another Card: Choosing this will connect the button 1o another card in the stack. When
you select this, you'll be temporarily remined to the current card, and a window will be
displayed that says "Move to the card that is the target of this button. Click OK when the
proper card is displayed. You can now use any of the usual HyperStudio Move menu
commands, (or even existing buttons on a card), 1o move to another card in the stack. When
you find the card you want the button to connect to, just click the OK button. You cannot
connect Lo a card in another stack. Use Connect to Another Stack for that

+ Next Card: This will automatically link the button on the current card to the next card in the
stack. Note that this connection is specifically to the next card. That is, if at some point in the
future you delete the target of this button, this button will not go to the new "next card”, but
will be unresolved since its actual target card is gone.

+ Previous Card: This is similar to Next Card, but instead creates a link to whatever card is
currently in front of the current card.

* Another Stack: You can also connect a button to an entirely different stack. When you
choose this item, you'll be presented with the File Interface, with which you can specify the
stack that you want to move to when that button is activated. There is no particular limitation
on the destination stack. That is, you can specify stacks in other directories, or even on other
disks. If the required disk or directory cannot be found when the button is pressed, the user
will be prompted to locate the required files.

Note: HyperStudio always looks first in the current directory for a given stack, graphic, sound,
application, or any disk-based item. Thus, you cannot connect to another stack in a different
directory if a stack with the same name exists in the same directory as the active stack, Also, if
you have a stack or application in one folder, and then move it, the connection will no longer
work because the target has moved. One way around this is to put the target stack or
application in the same folder as the branching stack. Then the connection will always work,
no matter where the total group of stacks and applications is located.

* Connect to Application: A button can also start an application. For example, you could
have a button start up AppleWorks, or any other application. When that application quits, it
will automatically return to HyperStudio. The application to be run is selected with the File
Interface. Afier you have selected the application, a dialog box will appear that asks whether
you want to return to the current card, the first card in the current stack, or the Home Card
when the application finishes. You can also elect 10 not retumn 1o HyperStudio at all, but rather
whalever program selector was used to launch HyperStudio, for example, the Finder.

Transitions: In each of the Connect To... actions, you also have the choice of a visual effect,
called a transition. A transition is a special screen effect that makes the movement from one
card to another more visually interesting. After choosing one of the above items, you also can
choose one of 16 transition effects. The fastest transition is the default one, labeled, coinciden-
tally enough, "Fastest”. Other effective transitions are the fade-to-white and fade-to-black. In
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gddiu'm_l, there are what are called screen wipes, which change one screen into another with an
interesting effect. The best way to understand what these do is to experiment with them.

Actions... When a bution is pressed, there are actions other than (or in addition to) branching
lo another card, stack or application, that are possible. These choices are also indicated:

* Play Sound: You can have a sound play when a button is pressed. If you choose this action,
ym;;;lll be asked whether you want to use an existing sound file on disk, or use the "live
record” mode.

Adding a Sound from Disk: If you choose to use an existing sound file, then you'll be shown
the usual File Interface, from where you can choose a sound file.

Once you have selected the sound file to use, HyperStudio brings up a screen with a picture of
]3 ls;]m recorder. There are also controls for playing the sound, and setting the playback volume
evel,

At this point you would click on the Play button to verify that this is the sound you want (o
add, and that the volume is satisfactory for your application. In the Preferences dialog box
(Apple menu), the user can set their own volume level, but this will help set the volume of the
current sound sample in relation to the others.

Once the sound is played the way you want it, simply click on the Done button, If you have the
Preferences set to Advanced User, you'll then be asked about the data access method. Other-
wise, you'll just go back to the normal HyperStudio program operation.

Note: If you have sound files from other systems, you should first load them in the Sound
Shnpm:grmn,andﬂmmvcﬂnmbackmdjskmﬂ]eSmndShnpfmnaLﬂﬂxisbucause
most sound files from other companies do not contain any information about the playback rate
and volume setting, and more importantly don't have a "signature” that clearly identifies what
system they were created on. Without these values, it is unlikely the file can be played directly
by HyperStudio with the desired volume and playback rates. The solution is to first load the
sound file in Sound Shop, and 10 then save the file back to the disk. Sound Shop uses an "offi-
cial" Apple filetype, and includes the information about the playback rate, volume, etc. in the
Eclmnd file. These values, in turn, are automatically used by HyperStudio when using the sound
e in a stack.

* Play a Video: A button-press can also trigger the appearance of a video sequence generated
by a Pioneer 2200, 4200 or 8000 LaserDisc player atached to the Apple 1IGS. This does not
control VCR players, or other video sources (see the Live Video demo in the Xcmds folder if
you have an Apple I Video Overlay Card (VOC), and want 1o experiment with video in
HyperStudio).
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The Pioneer 4200 is attached to the Apple IIGS modem port, using a simple modem cable with
the proper connectors on each end. You must make sure your "Slots” setting in the Control
Panel has Slot 2 set to "Modem", and the "Modem" setting is set to 4800 baud.

When you select this, you'll first be asked if you want 1o show video in the screen border. This
is only available with the VOC, and is used if you want the video image to completely fill the
monitor, Afier making your selection, a LaserDisc Control box will appear on the screen. If
you have the VOC, a rectangle will also appear in the center of the screen. This represents the
area where the video image from your video will be displayed on the screen.

If you have the VOC, HyperSwdio will then display a rectangle, with handles, that can be re-
sized and positioned as you wish. This rectangle determines exactly what portion of your
video image will be displayed on the card. Changing the size of the rectangle does not shrink
the entire video image into the new rectangle. Rather, this is just a "window" onto the video
image produced by the videodisc player.

If you don't have the VOC, you can still use HyperStudio to bring up a given image or se-
quence in connection with any particular card. If there isn't a VOC in the computer, HyperStu-
dio will display the remote-control box on the screen, but will not put a rectangle on the
screen. In this case you would use a second TV or monitor Lo display the output from the

A video sequence is defined by specifying the beginning and end frame numbers of the video
10 be shown when the current card is displayed. The radio button starts on the "Begin" setting.
Click on the Play or Step buttons to find the beginning of the sequence you want to use. If the
disk is Playing, clicking on Step or Pause will stop the disk on that frame, and update the
frame number register with the current frame number. You can also press the Clear key on the
Apple keyboard, and enter a new frame number. The player will then jump to that frame. To
set the ending frame, click on the "End" radio button, and then click on Play 1o let a few
seconds of video roll by. If you want to show only a single frame, just set the End frame # the
same as the beginning. Frame numbers can be entered manually, and you can use the TAB
key to switch between the Begin and End frame boxes. When you enter a number in a box, the
radio button will automatically move to that box.

You can test your video by pressing the Test button. When you get the sequence you want,
just click on the Keep button.

That's it! Now, whenever this button is pressed, the video sequence will be shown. A video
sequence is only played once when the button is pressed. If you want a video sequence 10
repeal at regular intervals, or after a set time period, see the discussion on setting the time
period for an "Auto-activate” button, which is described later in this manual.

A video sequence can also be attached to a given card, so that the video sequence is shown as
soon as the user moves o that card. See the Add a Video seciion later in this manual.
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Other LaserDisc Control Features:

While you are defining the video sequence, there are a number of features i LaserDi
Control box that you should be aware of: ’ i N

Play: You can play either forward or backward by clicking on the arrow buttons to either sid
of the word "Play". If the End frame number is less than the beginning frame number when ’
you finally choose "Keep”, then the sequence will be played backward,

!(Eﬂillnd: ;3? cliac!icing oul: the button normally marked "Stereo”, you can switch the sound off
silent”), or select either the left or right andio channels. Sound is not available at pla
speeds other than Normal. payhack

Playback Speed: By clicking on the buttons to the left and right of the word "Norm"

change the speed at which the video is playing, Faster speeds available include ¢ and an.
Slower speeds include half-speed down to 1/16 speed, and two special "slide show" modes of
ul?eﬁmwwylazsecmﬂs. Hemdmujwhmﬂwﬂdwwqmmeismhylhem
will be whatever the speed value is when you finally click on "Keep". Thus, you ¢an can use
_lhe fasEc.r speed settings when finding the frames you want. Just remember 1o set it back to
lh?'iﬂ:;laﬂ?:g:m clicking on "Keep” - that is, unless you deliberately want a different speed in

Chapter Mode: If you click on the buttons marked "Fm", 10 the right of the frame number
indicators, the button will change 1o "Ch" (for "Chapter"), and the number display will show
whmchapterdut!framqnmnbeﬁsfmnm in. If you click on the frame box while in the chapter
mode, the LaserDisc will seek to the beginning of that chapter,

Disphi:ﬁ If you s:fc li-'lnc the full-screen mode, and have an active show-through area in the
upper-left comer screen, then the current frame number will be displayed. Clickin
the Display button twggles the display between on and off. e e

Step: Clicking on either side of the word "Step" will move one frame forward or backward.

Start/Reject: If the LaserDisc player is not fully started when i i

: you bring up the LaserDisc
Control, then |.hc button in the upper-left comer of the box will read "Start”. Click on this 10
start the player if the other controls in the box are net yet visible. Once the player starts, this
button changes 1o "Reject”, and will eject the disk if pressed.

Creating a Full-Screen Video

In normal use, the video image (with the Apple II Video Overla i

m y Card) will only show through
lhg. region defined by the video rectangle used when Adding a Card Video. Hm{'eva. the *
Video Overlay Card works by defining a color as the "key-color”, or "show-through color” on
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the screen. Before a video is added o a card, the key color is purple. The purple hue on the
screen changes 10 a pure blue once a video object has been added to a card.

There are two degrees of "full-screen” on the Apple IIGS. The first is the active screen area,
excluding the border area. The larger full-screen includes the monitor border area as well.
You can design a card o use either method.

If you want to create a video image that fills the entire background of a card, you can do this
by painting the entire card background with the proper show-through color. The color o
choose for filling the background will either be purple or blue, depending on whether a video
has already been added to a given card, but its position in the color table will always be the
same: color #6. That is, in the "Colors" menu, choose the second color from the left in the
second row from the top. If you are using the "Set Background Color” menu option (Options
menu), use the 6th color choice from the left.

When your video image is displayed, the video will be seen across the entire screen, regardless
of the actual video rectangle. In most cases, you'll find it easier w just make the video rec-
tangle as small as you can, and then move the video rectangle to some out-of-the-way spot on
the screen (but still over an active video show-through area).

If you want the video image to fill the screen border area as well, then click on "Yes" when
first adding a video, when you see the dialog box asking if you want to show the video in the
screen border area. The only real difference between these is that HyperSwudio changes the GS
border color to the "key-color”. This will allow the video image to go to the absolute edge of
the monitor screen.

The advaniage of using the background graphic itself (as opposed to the video rectangle) for
the video show-through area is that it is easy to re-paint a rectangle or other area if you want to
change the image area. In addition, you can use the Add clip-art, or other paint tools, to
overlay labels, arrows, or icon-buttons onto your video image. You should also try drawing
some rectangles, with "draw filled" checked in the Options menu, in various colors. You'll
notice that colors range from completely transparent (blue) to completely opaque (black,
white, grey, and shades of red), and others are in-between. This can create very neat effects
that show a dimmed image of a larger video image, with a certain part "highlighted” by being
100% transparent, and thus brightest.

The real key here is to just experiment. You can't hurt anything, and you're likely to discover
many useful techniques in the process. Also remember to experiment with using the paint tools
to create small windows with video showing through. We've found that although the video
rectangle is the easiet to explain and use for beginning users, in the long run, using the paint
tools will give the most flexible results.
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» Trigger Xcmds: This is an advanced feature of HyperStudio that is available to those people
who want 1o extend the functions of HyperStudio beyond the built-in feamres.

When you choose this option, a dialog box appears that prompts you for the text which will be
passed to an Xemd. What you enter, if anything, depends entirely on the Xemd being called.

Here's an overview of the Xcmd system:

When any given stack is opened in HyperStudio, the same directory that the stack was in is
checked for a file named HS.Xcmd. If found, that file is also loaded into memory. Then,
whenever the user clicks on a button that has been given an Xcmd function, HyperStudio
passes control to the file (HS.Xcmd) that was loaded, and passes it the text that was entered for
that button as well.

Examples of Xcmds are included on the HS.Demo and HS.Art disks. For example, although
HyperStudio has a menu choice for finding text in a stack, suppose you wanted (o create a
button which, when pressed, would jump 1o a card that had a pre-defined phrase of text on it.
The demo "Find.Demo" in the Xcmds folder on the HS.Demo disk (click on Find Demo in the
Home Card) shows how this might work. You could put this function in your own stacks by
moving the file HS.Xcmd from the Find folder on the HS.Demo disk to whatever folder had
your own stack in it. To define the Find Xcmd button in your own stack, you would then just
creale a new button, and choose Trigger Xcmd as the Action. You would then enter the text to
be searched for whenever that bution was pressed.

Another example on the HS.Art disk is an Xcmd for displaying a single full-screen 320-mode
picture in a stack. See the demo Test.320.Stack in the Test.320 folder on the HS.Art disk. In
this Xcmd, you simply enter a number when creating the button that tells HyperStudio how
many 10ths of a second to pause between each picture in a slide show. Entering a value of 10
would pause 1 second. To show a single 320-mode graphic, you simply put the HS.Xcmd file
from the Test.320 folder in the same folder as your stack, and then put a single 320 mode
picture in the directory with it. See the Test.320.Stack for more information.

The HS.Demo disk has assembly language source files for those interested in pursuing this
area further. Xcmds can also be writlen in other languages like Pascal, so long as the language
can creale stand-along OMF load modules (such as NDAs) on the Apple IIGS.

* Animate: This is actually somewhat similar to Adding a Graphic (see later). The difference
here is that you can attach the appearance of a graphic, and its animation, to a button-press.
Choosing the Animate action will take you through a sequence which is the same as though
you were adding a graphic,

Some (but not all) graphic programs offer animation functions. Paintworks Gold and
BeaglePaint support an animation format where many different frames can be combined into
one file o make up an animated image. The animation is created with a series of Super Hi-Res
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pictures, with filenames that are numbered. An animation sequence for a bouncing ball might
consist of the files BALLO1, BALLD2, BALLO3, eic.

‘When you choose Animate from the actions menu, you go through a process similar to adding
a graphic object. The choice of disk files will include not only the usual graphics, but also
animation files (type $C2) from PaintWorks Gold. If you choose a filename that ends with a
number, the disk is checked for additional files that continue the sequence. For example, if you
used the file BIRD1 as a graphic item, HyperStudio would automatically look for the files
BIRD2, BIRD?3, eic., until it ran out of files.

After choosing a file, a window will open that shows the first frame of the animation. Only the
part of the graphic visible in the window you create is displayed during the animation
sequence, and if anything in your animation moves outside this area, then it will nol be visible.
Clicking outside the rectangle drops the graphic in place, and you'll be returned 1o the button
action dialog box. If the graphic you have specified is part of a numbered series of frames,
HyperStudio will generate the animation before retumning to the Actions dialog box.

In the Actions dialog box, you should enter a Rate and Repeat Count. The Rate is counted in
60ths of a second, and controls how fast the animation runs. Thus, a value of 30 would be two
frames per second. The Repeat value controls how many times the sequence repeats itself,

‘When an animation plays, it may clear an area slightly larger than the actual rectangle you
defined. This has 10 do with limitations in the method used by PaintWorks Gold.

Test Functions

On any card, buttons can be either "No test function” (the default), "Correct Answer”, or
"Alternate Answer”. Normally, when you are creating buttons to go to other cards, eic., the
setting is "No test function”, Buttons created this way are neutral, and have no effect on the
test status of a stack or card.

If you elect to make any button in a stack either "Correct Answer” or "Alternate Answer”, that
stack is now considered a "Test stack”. When a stack is quit, either by quitting HyperStudio,
launching another application, or branching to another stack, HyperStudio writes to a text file
on the disk, in the same directory as the stack, named HS.TestResults. The information
written includes the stack name, the time and date, a list of which butions were chosen on each
card in the stack, and a final "score” for thal stack. Information is wrillen o the
HS.Test.Results file on a cumulative hasis, so this one file contains the results of all stacks in
that directory that are used until the file HS.Test.Resulis is deleted. The HS.Test.Results file is
not writien o if there are no test function buttons in a given stack.
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The results for a given stack are calculated as follows:

When the stack is terminated, and the HS.Test Results file is written, HyperStudio scans the
entire stack to see what buttons were pressed as the stack was being used. For each card, it
writes out the card ID#, and which button on a card was the last one clicked on. If no button
mummrdwnscljckndun.mifﬂwbuumcljckadmma'Nor.&s:ﬁuttim'buum,mmnu
entry is writien for that card.

If the last button clicked on a given card was defined as either "Correct Answer” or "Alternate
Answer”, then HyperStudio will record the button name as the chosen button for that card. The
final score will be the number of "Correct Answer” buttons chosen {maximum one per card)
compared to the number of total cards with test function buttons on them.

There can be as many Correct Answer, Alternate Answer, or No Test Function buttons on a
given card as you want; only the last button clicked on is used in recording the resulis,

This actually is a fairly simple and straight-forward system, but you may want to experiment
with different kinds of stacks and button combinations o see what works best for you.
Different possible setups include:

* A simple multiple-choice test stack, where each card is one question. Each possible answer
button moves you to the next card. Correct Answer buttons are defined as appropriate;
Alternate answer buttons are used for the others.

* A variation on this is to include forward and backward arrow buttons on each card, defined
as No Test Function. Clicking these will not affect the "last button clicked" status on any
given card. That is, you could click on a choice (perhaps that responded with a voice
confirmation), and then click on the forward button. HyperStudio would still record the button
chosen, and would ignore the forward button,

* A timed test, where each screen also includes an aulo-activate button that moves to the next
card after 10, 20 or 30 seconds (or whatever). The user would have to choose one of the
possible answer buttons in the allotted time period. The final HS.Test.Results file would
record which button on each card had been chosen.

To use the test results, you should load the HS, Test.Results file into a word processor. It is also
possible to write simple Applesoft programs that will read the file, and organize the data, but
this is a custom application that depends on your own time and interests. You could also
specify the file HS.TestResults as the source of a text item in another stack, using the extended
data access method. :

The test functions can be used not only for the classic sort of tests, but also for user profiles as
well. Imagine a stack that begins with a picture of three bowls of ice cream, Each of the .
bowls is set up as an invisible button, each named "chocolate”, "vanilla”, and "strawberry”. At
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the end of the stack, the HS.Test.Results file will create a file that tells you which button they
selected. In this case the "Correct” or "Aliernate” answer aitribute for a bution doesn't matier
(although it must be one or the other). What you're getting is the information about which item
they chose on a screen. If 100 people were 10 use this card in a stack, then the HS.Test.Results
file would contain a survey of 100 people, and a study of the percentage of what flavor ice
cream was preferred.

Auto-Activate Buttons

Normally, a button has to be clicked on by the user 10 be activated. Suppose, however, that
you wanted a sound to play immediately when a card was displayed. How could you do this?

The answer is with auto-activate buttons. An auto-activated button "presses itself™ after a set
number of seconds after a card is displayed. The button can also be set to continuously cycle in
the time period se.. To set up an auto-activate button, just check the anto-activate box, and
enter a time (in seconds) after which the button should activate, If you want the button to
repeat its action, check the repeat box also.

Another use for Auto-activate buttons is o prompt the user if they don't elick on something on
the screen in a certain amount of time. This could be a help card, or it could also be used 1
create timed tests.

Auto-activate butions are not active (at least not self-umed) until you tum on the Auto-activate
function in the Preferences dialog box, and you are in the browse mode. This is so that you
don't have to worry about auto-activate buttons going off while you're trying to edit other parts
of a card. Auto-activate buttons are automatically turned off when you select a paint or editing
tool, and are not tumed back on until you select the browse tool and move o another card, or
turn on Aulo-activate in the Preferences menu.

Adding Other Objects, Continued...

Add a Graphic: This menu item is used to add a graphic object 1o the current card. When you
choose this, you will be presented with the File Interface for choosing the graphics file you
want io use. Once the graphic has been selected, and if this is the first graphic you have added
since starting up HyperStudio, you'll get a dialog box explaining that the next step is to size the
graphic 1o the size you want, and to position it on the card.

Remember when adding a graphic to a card that the graphic retains its own identity as an
object on the card. This is in contrast to just adding a portion of a graphic screen as clip ar.
This feature is best used when you have many cards with an identical background. If you are
just adding some graphics to a card, it is better 0 use the Add Clip-Art function in the File
menu.
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After you have chosen a file on the disk, a rectangle is displayed that shows a portion of the
graphic screen you selected. You now have 1o decide how much of the image you want
displayed on the card, and where you want the graphic located. By putting the mouse
anywhere inside the rectangle, holding the mouse button down, and then dragging the mouse,
you can move different parts of your graphic image into view. If you want to re-size the
rectangle, use the mouse to grab any of the handles on the sides or comers. Dragging any part
of the frame that is not a handle will move the entire rectangle 1o a new position. Remember
that the window "frame” is only shown so that you can size the window, and scroll the image
area. Once positioned on the card, the window frame is not shown unless you edit the graphic
again.

When the graphic has been positioned and sized, click anywhere outside of the box to indicate
you are done positioning the graphic. You'll then be shown a choice of borders that you can
use for the graphic. If your graphic is a picture that is very different from the background,
you'll probably want to use a border. On the other hand, if you want the graphic to look like it
is a part of the card, and presuming that the background in the graphic is the same color as the
background on the card, then you can use "No Border”.

Unless you have the Preferences option set to Advanced User, you're now done, and you can
go on to your next operation in HyperStudio. If you have set the Advanced User option, you'll
then be asked to set the data access method. See the section on the Advanced User option for a
detailed discussion of the choices.

Add a Text Item: If this is the first text item you have added since starting up HyperStudio,
you'll get a dialog box explaining that the next step is 1o size the text box to the size you want,
and to position it on the card. Successive text file selections proceed the same; they just aren't
preceded with this "help” box. After clicking on "continue”, a rectangle is displayed that shows
where the text rectangle will be placed on the screen. You can resize and reposition this
rectangle, just as you would an invisible button. Drag the center of the rectangle to reposition
it; drag the comers to resize.

When the text item has been positioned and sized, click anywhere outside of the rectangle to
indicate you are done positioning the rectangle. You'll then be shown a dialog box that gives
you the options of using scroll bars, a rectangle around the box, and whether the text item will
be changeable by the user or not. You can select any of these atiributes as needed.

You also need to decide if you want to use text from a file already on disk, or if you want to
enter text directly,

* Using a Disk Text File: If you choose to use a file from disk, you'll be presented with the
File Interface for choosing the ASCII text file or AppleWorks 2.1 word processor file you want
to use. The text file will then be loaded, and the text will appear in the rectangle.
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Remember when adding a text item 1o a card that, like the graphic item, it retains its own
identity as an object on the card.

Afier you have chosen a file on the disk, if you want to resize, reposition, or change the
attributes of the text box, you can use the text tool in the Tools menu, select the text item, and
then choose Item Info from the Objects menu.

Unless you have the Preferences option set to Advanced User, you're now done, and you can
g0 on 1o your next operation in HyperStudio. If you are using the Advanced User Options,
you'll be able to decide whether to imbed the text in the stack, or o use the extended (disk-
based) data type. See the section on the Advanced User option for a detailed discussion of the
choices.

» Entering Text Directly: Afier choosing "Add a Text Item" from the Objects menu, if you
then choose to enter the text, you'll go immediately to the text box on the screen, where you'll
be able 1o enter text directly. Text is entered in the Browse Mode, so you can go on to another
activity at any time. There is no particular action required o end entering text.

As with text items created from a disk file, you can always use Item Info in the Objects menu
Lo resize, reposition, or change the attributes of your text item, Text in the text objects is
always in the Shaston B typestyle. If you want to put text on a card in other sizes and styles,
such as for titles, etc., you can use the text paint tool (Tools menu).

Add a Video: In this menu item, the procedure is identical to that for adding a video sequence
10 a button. The only difference is that the video will be added to the card itself, and will be
played when the user first moves to that card. See the description of playing a video on a
button-press for additional details.

Colors Menu

This menu is used to set the current color for the paint tools. HyperStudio uses 16 standard
"dithered” colors in the 640 Super Hi-Res mode of the Apple [IGS, plus 16 additional pattern-
type colors, for a total of 32 usable colors. You can load pictures created with other paint
programs that have custom palettes, but you must use some care in using these graphics on a
card. The main problem is that the custom paletie may interfere with the appearance of the
menu bar, or other buttons or graphics on the screen. Full-screen backgrounds with no menu
bar, and invisible buttons, generally work best for custom-palette graphics.

You can also use the Add Clip-Art function to set the current card to a custom palette. Just
choose Add Clip-Art in the File menu, and load a graphic that has a palette you would like to
use. Now, clip a small part of the graphic, and paste it onto your current card background.
This will change the palettte on that card. If you want, you can then cut the bit of graphic back
out of your card if you don't want 1o use the image itself. The HS.Ar disk includes several
files, including Colors.Greys and Colors.Earth that can be used in this way to set the palette for
any given card using the Add Clip-Ant technique.
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Options Menu

'miliis used to control the operation of other functions in HyperStudio, in particular the paint
tools,

Line Size: This sets the width of the line 10 be used by the straight line, rectangle, rounded
rectangle, oval, and polygon tools. When you choose this item, you'll get a dialog box that
shows a number of different line sizes. Click on the one you want to select a given size.

Brush Shape: This chooses the brush shape 1o be used by the paint brush tool. When you
choose this item, you'll get a dialog box that shows the different brush shapes available. Click
on the one you want 1o select.

Draw Filled: Choosing this item places or removes a checkmark that indicates whether the
shapes drawn with the rectangle, rounded rectangle, oval, irregular region and polygon tools
will be filled with the current color or not. A checkmark indicates that these shapes will be
drawn as a solid shape.

Text Style: When either using the painting text tool, or editing a text object, this menu item
selects the current fon, size, and style of the text being used. The fonts available will depend
on what fonts you have in the Fonts folder on your startup disk. This does not have any effect
on the text in a text object. Text objects are always in Shaston 8.

Set Text Color: This is used to set the color used when you type text with the text tool in the
Tools menu. This does not have any effect on the text in a text object.

Set Background Color: This is used to set the background color used when you erase a
background, or use the eraser ool in the Tools menu.

Hide Items: Ordinarily, any particular card would have not only the background visible, but
also any g:*aptur:s. iext items, buttons, etc. This option lets you hide items, in case you want to
use the paint tools on the background without objects in the way.

Hide Menu: This is used to hide the menu bar on a given card. If the menu bar is hidden
when you move off a card by using a button, then the menu bar will also be hidden when the
user views that card. This allows you to create stacks without a menu bar. Press Apple-M to
restore the menu bar.
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Apple Menu

The Apple menu has an "About...” box that tells you the version number of HyperStudio.
However, the most important function in this menu is the Preferences choice.

Preferences

The preferences seitings are saved in each individual stack, and may vary between stacks. The
stack must be saved back io the disk after changing preferences if you want the changes to be
in effect the next time the stack is used. Preferences lets you control many aspects of a stack's
operation:

Password: This is to keep users from changing the preferences in a stack you have created.
The main thing protected by the password is access to the "Lock Stack” setting (see below). If
the password field is blank, then all the options are available when Preferences is chosen.
However, if you enter a password and exit the Preferences dialog, and then save the stack, this
password will be required the next time the Preferences dialog is opened. You'll also notice
that pressing Return is not required when entering the password. When the last letter of the
correct password is typed, the dialog box options will instantly become active.

Advanced User: This is used to tell HyperStudio that you would like more control over how
the data for objects on each card will be stored and accessed. Normally, HyperStudio embeds
the data for each object that you add right into the stack that you are creating, without asking

you how you want the data accessed. This is less confusing to a new user, and creates fast and
easily transportable stacks. However, if you have set the preference to Advanced User, you'll

then be given some options about how you want the data for objects 10 be accessed by Hyper-
Studio.

From then on (or until you change the Advanced User Option to "off”), whenever you add a
graphic, text object, or sound, at the end of the process you'll see a dialog box asking you to
"Select the Data Access Method for this Item:"

The two choices are "Embedded (In the stack)”, or "Disk Based”. Here's what these choices
refer to:

» Embedded Data: When you add a graphic, sound, or text item to a card, the default is to
actually store the data for that item within the stack itself. This is both convenient and gives
faster movement between cards in your stack. The other advantage of this method is that your
stack is very transportable. That is, since everything that makes up that stack is within the file
itself, moving the stack from disk to disk is as simple as copying a single file. This type of
object is also called an embedded data object.

However, suppose you wanted to create a stack that used literally hundreds of graphics, text,
and sound items, Even with megabytes of memory, you would soon want to have more data in
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your stack than could actually fit in the computer's memory all at once. It is also possible that
at some point in the future, you may want to access data, such as that on a compact disk or
laser videodisk, that cannor be physically imbedded in your stack.

* Disk Based Data: In all of these cases, HyperStudio provides an alternative way of access-
ing text, graphic, and sound items. The second choice, Disk Based access, gives you the option
of leaving the graphic (or other) file in its current location, and having HyperStudio go back to
that location whenever it needs the graphic. This is called an extended data object. Although
this gives a slower transition time between cards, it significantly increases the overall size of
the stack that you can create, and the data il can access.

The second advantage of the extended data type is that other users of the system can update the
data displayed on a card independently of HyperStudio. For example, you might have a draw-
ing on a card as a graphic item that showed the fire exits to new employees. If for some reason
the fire exits were changed, by updating a single document - the graphic picture - all stacks that
referenced that illustration would be automatically updated as well. This is a very powerful
concept, and works well in situtations where the computers are operating on a nefwork.

As an aside, this also makes the instant distribution of all kinds of information possible. This
could include memos to staff, names in an organizational chart, instructions to students, or
often-changing data like price guoles, etc.

The default in HyperStudio, when shipped, is to always use the embedded data system. This
means the user has less to worry about, and stacks are easy to move and operate. On the other
hand, as an advanced user, you may want to take advantage of the alternale data access
method.

Also, when Advanced User is set, you will not get the small instructional dialog boxes the first
time a button, text or graphic item is added.

Auto-activate buttons on: In the manual, auto-activate buttons are described as those buttons
that activate themselves after a set amount of time. While editing a stack, however, you may
not want the auto-activate buttons going off while you're trying 1o work on a card. By uming
off the check-mark in this option, auto-activate buttons will not be triggered unless you manu-
ally click on them. When you are ready to save your stack for the final user of your informa-
tion, set the check-mark in this box, and save your stack 1o the disk. Auto-activate buttons are
automatically turned off when you select a paint or editing tool, and are not turned back on
until you select the browse tool and move to another card, or turn on Auto-activate in the
Preferences menu.

Lock Stack: If you are designing stacks for use by others, and in particular, situations where
you don't want the user to be able to use the editing tools, you can select "Lock Stack” in the

Preferences menu (remember to save the stack after making the change). Unlocking the stack
restores the complete menu bar. Since the Lock Stack option is available via the Preferences
function, it is advisable to always sel a password if this option is going to be used.
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Show card number in menu bar: When this is enabled, you will see the number of the
current card displayed in the right side of the menu bar. This is useful whrmcmmng and
editing stacks, although you'll probably want to turn this off when the saving the stack for the
final user.

Erase background on mew card: When this is checked, HyperStudio erases the backgm_und
when "New Card" is chosen in the Edit menu. However, if you are using a background, like a
notd:mkpage.ﬂmmbeumdmmydiﬁ‘ermtcardsinamk,mmymwﬂlwmttomakc
sure this option is not checked (tumed off). Now, whcnyouchmseNEwCard.:l'_le'cmnt
background will automatically be used by the new card. Since there may be no visible sign a
new card has been created, you will probably want to have "Show card number in menu bar
tumed on.

Remember that when a background is duplicated for a new card, the background is actually
shared between two or more cards. This can have significant memory savings, but only if you
don't alter the background on duplicated cards with the paint tools. You can alter !M‘pnma_ry
card with the original background (with duplicated results!), but if you paint or otherwise edit
other cards, the background will become an original background on the edited card.

Use TouchWindow: This option lets you use HyperStudio with the TouchWindow from
Edmark Corp. This is a very useful add-on with HyperStudio, and lets you use your stacks
with very young children, and anyone who is new to computers. Touching the screen becomes
equivalent to clicking with the mouse with the TouchWindow, and makes for a very pleasant

compuler experience.

When you check this box, and then click on Ok in the dialog box, it is assumed that you have a
TouchWindow currently attached to your computer. At that point, a dialog box appears
explaining that the TouchWindow will need to be calibrated by touching each comer of the
active screen area (this does not include the monitor border area). Once activated, the
TouchWindow will stay active until you exit HyperStodio.

This function is not stack-specific, and when HyperStudio is run again, the TouchWindow will
have to be re-activated and calibrated. This does not have 1o be repeated for different stacks. If
the TouchWindow calibration is not correct the first time you do it, you can re-calibrate by
turning off the TouchWindow in the Preferences menu. Exit Prcfe.remeg. and then choose it
again and turn the TouchWindow back on. You'll then be able to re-calibrate the screen. When
calibrating, try to not drag your finger as you touch each comer. Remember, you're trying to
tell the TouchWindow where a specific point (the comer of the screen) is. Turning off the
TouchWindow once it has been started up may interefere with keyboard commands. Keyboard
commands will be properly recognized once you leave HyperStudio, or re-activate the
TouchWindow.

Volume Control: This slider lets you control the overall volume level of the stack in memory.
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If you get a stack that plays sounds using the built-in speaker, for example, the sounds will be
too loud if you are using an external speaker. Likewise, if you have a stack that was set up
using an external speaker, it may be too quiet using the built-in speaker on the GS.

The volume in HyperStudio is controlled by a combination of factors. The Control Panel
volume is factored into the overall sound volume in all HyperStudio stacks - this is the system
volume. If you want to change the overall playback volume in a stack, use the slide control in
the Preferences section - this is the stack volume. If you want the new volume to be perma-
nent, remember o save the stack back to disk. The volume of a particular sound is selected in
the tape deck screen when a sound is first added.

More About Data Access Methods

Local Data: There is also a third access method that is a variation of the extended data type.
However, this method is dependent on how you store your files on disk, rather than a specific
choice in HyperStudio.

When HyperStudio tries to locate the file for disk-based data, it first looks in the same direc-
tory as the stack, regardless of what the absolute location of the data was when it was linked to
the stack. Data located in the same folder as a stack is called local data.

The main advantage to putting all the disk-based data in the same folder as your stack is
transportability. Suppose you had created stacks on your own hard disk that referenced text,
graphic and sound files in various locations on your hard disk. If you then wanted to move the
stack onto a 3.5" disk, the only way to run the stack would be to have the hard disk attached to
the same computer that the stack was running on.

With a standard extended data item, the entire data remains in a disk location which must be
available when the stack is used. When it comes time to move the stack from one disk 1o
another, it is unlikely that you will be able to easily move all of the data files referenced by a
given stack, especially if the data is located on many different disks.

By keeping all the data files referenced by a given stack in the same folder, moving the stack is
as simple as moving the entire folder from one disk to another using any file copying utility
such as the Finder, DeskTop, Copy I+, ProSel's Cat Doctor, etc.

In general, when designing a stack, you can use the following guidelines:

* When the entire stack can fit in memory all at once, use the imbedded data type. Stacks
done in this manner are also much easier to distribute to others.

» If the stack will be running in a stable environment, where the referenced data does not
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change in its location, and you want to have common files that are accessed by a variety of
different stacks, then the extended data type is recommended.

« If you are using disk-based data because of memory considerations, and you anticipate
moving your stack to another disk, then move the referenced files to the same folder as the
stack.

File Location Dialog Boxes

When HyperStudio cannot locate the volume that a data file is located on, it will first display a
dialog box asking you to insert the needed disk. If you cancel this dialog box, then you'll get a
dialog box asking you to manually locate the file on any disk or folder. If you cancel this
dialog box, then HyperStudio will skip that data item in building the card, or executing a
bution action, and will continue as well as possible.

Last-used directories

When adding clip-art, sound files, loading stacks, etc., HyperStudio remembers the last-used
directory for various kinds of data. This makes it easy to go back to the last directory you
loaded something from. However, you should also remember that if you put artwork, sounds,
eic. in other directories, the first time you go to add clip-art, you will have to use the Standard
File interface to open the necessary folder. If you have a large number of HyperStudio-related
files, you may find that organizing subdirectories is both useful and necessary.

Alternate Home Cards

The Home.Stack on the HyperStudio disk has been set up with the beginning user in mind.
The Home Card in this stack shows the stacks available on the different disks in the HyperStu-
dio package, and also inviles you to a special screen (the Just Starting... icon) if you are new to
HyperStudio. From this second screen, you can see what different areas of interest have been
addressed by various stacks.

However, once you've used HyperStudio for a while, you may wish a more direct Home Card,
without the Just.Starting... icon. On the HS.Demo disk, you'll find an alternate Home Stack
that may be more efficient for daily use of HyperStudio. Also, remember that the Home Card
is just a graphic image with invisible buttons. You can use the paint tools to create your own
unique Home Card, such as a picture of a desk with items on it, the bridge of a starship, or any
other interface that makes it easier for you or the person using HyperStudio.

HyperStudio Sound Shop

The Sound Shop™

The Sound Shop utility is designed to let you digitize, edit, and save sound files for use with
the HyperStudio system. Although HyperStudio lets you record a sound while you are creating
a siack, the Sound Shop is provided to give you more control over all the aspects of the
recorded sound. It can also be used for converting sound files from other sources, such as
public domain sound sample disks, and sounds recorded with the MDIdeas, FutureSound, or
Applied Engineering products.

To run the Sound Shop, click on the Sound Shop icon in the HyperStudio Home Card. Sound
Shop can also be launched, like any GSOS system file, from the Finder, Program Launcher, or
other program selector,

Using Sound Shop is very easy, and the best place to start is with recording a sound using the
microphone, and then seeing what you can do with it!

The first thing to notice on the Sound Shop is the overall screen layout. The blank window in
d?ewphslfoflhcscrwnismremcsuundwavefm‘whamw:rsumdyoumom'dorhad&um
disk will be displayed. The window is blank now because there is not a sound in memory yet.

Below the wave display window are three boxes that show important number values about how
much memory you have available for recorded sounds, how much time that represents at the
current record and playback rates, and other useful values,

The scroll-bar controls at the bottom of the screen are used to control the recording and play-
back of sounds in terms of volume, record/playback rates, an “"echo" special effect, a repeat
count, and the start-recording threshold value.

To the right of the status boxes are three yellow buttons. "Record" starts the recording process.
"?Iay" starts the playback, and "Stop" is used to stop the playback. Above these buttons is an
"input level” indicator, and is used to check the current "level” of the sound input device, such
as the microphone, tape input, etc. The Play and Stop buttons are disabled because there is no
sound to be played yet.

A Brief Test of the System

Bﬁnrc starting, you should have already installed the HyperStudio sound recording card
(digitizer) and microphone according to the installation instructions at the beginning of this
manual. If you have not already done so, go back and install these devices now.

an‘ microphone should be plugged into the back of the computer. If the microphone is
functioning properly, you'll see a green vertical bar just above the Record button. This is the

Page 57




Sound Shop HyperStudio

level indicator, and is used to make sure that a sound input device is both connected, and, if
necessary, set to a sufficient volume for a good recording. The green bar should move up and
down as you speak into the microphone. If the microphone is not attached, the bar will be red.
The bar also turns red whenever the input signal is too strong for a good recording, such as
when you shout into the microphone, or if the volume were tumed up too high on a tape player
attached to the digitizer card. The bar should not be red under normal conditions if the micro-
phone is attached, and there is no excessive sound input.

You are now ready to record something. Before you record, check the Record Rate and
Playback Rate controls at the bottom of the screen. For now, both these values should be
10435. The rate value tells you how much memory is required for each second of sound
recorded. In this case, you will use 10.4K of RAM memory per second. This is a good rate for
recording a voice. We'll look at this in more detail later, but for now, the important thing to do
is to make sure the values are the same for both record and playback.

The other settings should be at their default values:

Echo Delay: off
Record Threshold off
Play Volume 6

Repeat Count off

To record your voice, click on the Record button with the mouse. When you see the screen
border turn red, count into the microphone: "One, two, three, four” (and pause just a little
between each number!). The level indicator will not be active during a recording. It is only
used 10 check the level prior 1o recording. Press the Return (or any other) key 1o stop the
recording. (Stop is only vsed for stopping the Playback function),

Note: When recording your voice using the microphone, you will have to speak "firmly” for a
good recording, but an overly loud, or shouting voice is not required. Holding the microphone
close to your mouth will help. The right level is sometimes called a "radio voice”, that is, the
way a radio announcer would speak into his microphone for best clarity and volume. This
works for them, and it will work for you!

The default value of 6 for the playback volume has been set up for best results when using an
amplified speaker like the optional HyperStudio powered speaker. If you are using the
internal speaker, adjust the volume control to a value of 10.
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After a brief pause, the wave display window will be redrawn to look something like this:

ok File Edit Teols Sound  Settings
Curreat file nawe [5: 0NE.2.3Y

" cr T
WEWDRY STATUS BUFFER SWTUS D ITOR STHTUS
Totel memory 1197664 | Somple sive: W1TH $i: 0
Wozinum time:  179sec. | Record time:  $dnec. | Stort: 30201
Rwailable: 1255436 Plogtime:  Nuee End: @
Clipboerd: empt Clip time: empty [Lewvel: 0

T

The data you have just collected is sometimes called a sound sample, and is a digital recording
Pf your voice. At the current rate seiting (10435), the computer is checking the microphone
input abou_t rqmo times each second, and recording a number value for each moment. When
merw:rdmg:smmplcwd.lhedamwiubegnpmdonltuscm.mamnﬂﬁnggnphm-
sents the sound sample. Each grouping in the sound wave is one of the words you spoke. The
computer plays back your sound sample by re-scanning the data, and sending the recorded
signal back out to the speaker,

To hear your recording, click on the Play button, and listen to the sample. Play it several times.
Try;p'css;pguwSmphuumhﬂmmiddleofuwplaybact.Nowlet‘splonemhnhheomu
funcutmsmtheS{umdShop.mdsecwhukindsufﬂllngsSnmdSthwi]lletymduwirh
your recording.

Playback Rate: Use the mouse to change the Playback Rate (the slidebar control near the
bom)mofﬂmscrecn].‘l’ryvalumufaboutm,fll}ands,ﬂm.lfdmﬁaybmkﬂmisﬁ.nu(a
value larger) than the Record Rate, the pitch will be higher, and the sound sped up; if the
Playback Rate is slower, the pitch will be lower, and the sound slowed down. When you save
the sound sample 1o disk, the playback rate setting will be saved with the file.

Playing Part of a Sample: Set the Playback Rate back to 10435. Now move the mouse
pointer until it is in the sound wave window, and positioned at the beginning of the third sound
wave group. Press the mouse button and hold it down, and drag the mouse until the entire wave
group is highlighted. Then release the mouse button.
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WUFFER STATUS ERITOR STATUS |4

Total memory 1297664 | Songle slze: WAT2E Sizer 7090
ting:  IMisec | Recordtime:  §3uee. | Stort: 29610
Rveilable: 1253938 Floytime:  Wsee, | End 1010
Cliphbord:  ematy Clip time:  emph Level: -1

Record Kote mii “iiﬁlm 10033 Eeunnﬂ i"
'Il:ﬁ‘l'hrllihnll off Plul'll1.= i Iliuiilul aff

This is how you select part of the waveform in Sound Shop. Now press the Play button. Notice
that only the waord "three” is played. Whenever you select a portion of a sound, Sound Shop
plays only the part selected.

Volume: This controls the playback volume of your sound sample. It does not affect the
recording volume. Like the Playback Rate, the Volume setting will be saved when your sample
is saved to the disk. This is so that you don't have to adjust this control within a StudioWare
application if you don't want to. Try changing the volume now to see how it affects the sound.
Because of the way in which sound is done on your computer, very high or low volume
settings will not sound as good as the moderate settings.

Repeat Count: This controls how many times the sound will be repeated when it plays. This
might be used, for example, with sound effects like a gunshot or footstep. When the sound is
repeated a few times, you can get interesting effects without taking up the large amount of
memory that a larger sample would require. Try changing the Repeat Count to 3, and press
Play. You should hear the word "three" said three times.

Echo Delay: This controls a delay within the computer between the repeated playing of the
sample. Each repeated action, however, is started while the previous playback is still playing.
The result of any given value depends on a combination of the sample length, the Playback
rate, and the Echo Delay value. Even slight variations in the Echo Delay value can produce
different effects. In general, the echo effect will vary between a "close” echo, reminiscent of
singing in the shower, and a "larger” echo, like that of a stadiom.

The best approach is to start with an Echo Delay value of, for example, "40", and then play the
sound sample. Then adjust the Echo Delay 1o 39 or 41, and try again. Experiment until you
get just the effect you want.

Remember to set the Echo Delay back to "off" before trying the functions described mext. It
doesn't hurt anything to combine it with other functions, but there will be less confusion if you
leave it "off” for now.
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Record Threshold: Ordinarily, recording staris soon after you press the Record button.
However, suppose you want to start the recording process only when the sound actually starts.
The Record Threshold lets you specify a number value that represents how loud the sound
should be to trigger the start of the recording process.

To see how it works, first do a recording with the Record Threshold set to "off". This means
recording starts as spon as you press the Record bution. Before recording, click the mouse in
the wave display window once 10 deselect "three”, if necessary. Then, press the Record button,
wait for a few seconds, and then say "one, two, three". Then press the Return key to stop the
recording. Your recording should look something like this:

ok File Edit Tools Sownd  Sevtis

KEHORY STATUS BUFFER STRTUS

Total memary: 1207664 | Somple size: WhEVE Sire HO1y S

Hoximum time:  124sec, | Record time:  $3sec. |Stert: 7172 |8
Rvailoble: 1730816 Flogtime: Wsee | End 36186 s
Clipbosrd: empty Clip time: emgty  |Level: -2 Chiadebact

IIEI‘ Hii “E 4 ck Rate 10435 [:hnhla ¥y

Record Threshald  off P]='H|I-| I Iﬂi i=i aft
[ e R R T ]

Thc‘relativc!y flat area at the beginning of the waveform is the time you were pausing before
starting to count. This wait wastes memory. If the sound you want to record is not predictable,
you could use up all the available memory just recording the waiting period.

Now set the Record Threshold to 10, and press Record again, This time the screen border will
turn to green. Wait a few seconds once more, and then count "one, two, three” and press
Retumn to stop the recording. As soon as you started speaking, the screen border should have
changed to red, indicating that the recording process had begun.
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This time the recording will look like this:
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This time there is no wasted space at the beginning of the recording. The number value you
choose depends on the sound you are recording. The center line of the waveform window has a
value of zero. The very top and bottom of the window represent values of +127 and -127,
respectively, If the sound you are recording has large peaks (i.c., is relatively loud), you can
use a high threshold value, for example 50-100. On the other hand, if you're trying to capture a
quieter sound, a smaller value like 5-10 would be better.

Now let's look at some of the menu functions in Sound Shop.

File Menu

This menu is used to save sounds you've recorded with Sound Shop onto a diskette, and to
load the sounds back into the Sound Shop or HyperStudio. Use the mouse to pull down the
File menu and examine the entries. For many of the menu commands, there is a keyboard
equivalent. That is, you can press a key instead of using the mouse and menu. For example,
pressing N gives the same result as choosing New from the File menu.

New: [(JN] This erases whatever sound is currently in memory.

Open: [30] This loads a sound file from disk. When first chosen, Sound Shop shows the
files in the same directory as where the Sound Shop software was located when it was run. On
the HyperStudio disk, this will be the pathname /Hyperstudio. There is another disk in the
HyperStudio package, called HS.Sounds, that has a sampling of digitized sounds. Try loading
a sound file from this disk.
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To load a sound file, select the file you wish to load, or Cancel to go back to the main screen.
ChclungonDmkchmguﬂwditbeingemhwiﬂicﬁngm%chmﬂmfolﬂu(ﬁmy}
dmmmcmmyin.mdrcunmyoumapmvims"levul"inthcd.iakcﬁ:mcm.

Note:Hyuuhgverq:mﬂcdamad,arlmda:lamndﬁleanﬂthmnﬂﬂeachungcl.oit.using
meomﬁmmpnmnﬁmbﬁngupadialogbuxmalmindsywu:ecmmﬁ]chumbecn
saved. If you click on "Yes" (lo save the file), you'll be shown the current disk directory, where
_mucanmtgnhcnametnsavctbeﬁlemdw.Aﬁuuvingﬁcﬁlc.ym‘]]bcimmdimety
prescnwdmmrhedlskdi:u:magainmyoumunpenlheﬁlcyunwam]fymchmsc"hio"
(not to save the file), then the sound file you load will completely replace whatever sound file
is currently on the screen.

Save: [(3S] This function is used to quickly save a file under the name that it currently has.
You cannot use this function until you have done a Save As (thus giving a new recording a
name), or unless you have loaded an existing sound file from disk (in which case it already has
a name). Once the filename is known, this menu item will read something like "Save File-

name -,

Save As: Thisisus:edmsaveaﬁlemamwme.mﬂisrequjmdbsaveanewmumding
where a new name is required. As with the Open command, you'll be shown the current disk
directory, and asked for the name that will be used when saving the file.

Revert: This is used to re-load a sound file on the disk, without having to through the more
lengﬂmyOpcnmum.ﬁremph.fmhaveloﬁedamﬂﬂegwﬁsk,m:mw
changes, and then decide to start again with the original file, just choose Revert (which will
acum]]_ymadsunnuﬁngﬂkckcvenm'ﬁknm“). This loads the original file, completely
replacing whatever sound file is currently on the screen.

Quit: [3Q] Choose this when you want to quit Sound Shop, and return 1o your program
splecr.m'. If you have not saved the sound sample currently on the screen {urymac!e changes
since the last change), you'll be given an opportunity to save the file before you quit.

Edit Menu

This menu contains the cut, copy and paste functions, and other useful commands related to
editing your sound sample.

Undo: [(3Z] This is used when you want to change your mind about some editing action you
have taken. Not all actions can be undone, but many can. If you cut a portion out of a sample,
-::h:onmng Undo puts it back. If you paste some data into your sound sample, and change your
mind, Undo removes what was just pasted, and leaves the clipboard with the data still on it. If
you are new to the idea of the clipboard, and copying and pasting data, the next sections will
explain this in greater detail.
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Cut, Copy and Paste: [3X, GC, & (V] These three functions are used together to either
remove part of a sample and move it 10 a new position in a sample, or to copy a portion of the
sound from one position in the sample to another. There are also special effects that can be
done by combining these editing functions with some of the Tools functions described a little
later.

Selecting Cut from the Edit menu removes part of your sound sample, and puis it on the
computer's clipboard. The term "clipboard” is used to suggest how the editing process works.
Using the mouse, you first select a part of the sample on the screen. For example, record the
words "one, two, three, four” as you did earlier. Now use the mouse to highlight the third wave
group on the screen, which corresponds to the word "three”. You can check this by pressing on
the Play button after selecting the desired part of the waveform. You should hear just the word
"three".

Now use the mouse to pull down the Edit menu, and choose Cut. After a brief pause, the
screen will be redrawn, now with just three wave groups. Click on the Play button. You should
hear your words "one, two, four”. "Three" has been cut from the sample. To hear what is on
the clipboard, choose Play Clipboard, which is near the bottom of the Edit menu. You should
hear just the word "three".

Now, for fun, position the mouse between the first and second wave groups, and click once. A
marker bar should appear. This is used to indicate where you want data from the clipboard o
be placed. We can now insert the word "three” in the sample by using the Paste function.

Choose Paste now from the Edit menu. Again, there will be a brief pause while the sound on
the clipboard is pasted into the sound sample at the marker bar. When the waveform is re-
drawn, you'll again see four sound groups. Press the Play button to hear the edited sample.
Now it should count "one, three, two, four”.

The Copy function puts a copy of the selected sound portion on the clipboard, but does not
remove it from the original sample. This is most useful when you want to use the Layer
function in Tools menu. See the Layer command for a description of its use. You can also use
the Copy command to get part of the sound from one file, then load a second file, and paste the
sound portion into the second file.

Important!! If you are copying and pasting between two separate files, and the playback
rates in each file are different, you will get accordingly strange results.

There is really no way to get around this problem, other than adopting the habit of trying to
minimize the number of different recording rates you use when you create your sound
samples. Although the Sound Shop provides a very wide variety of record and playback rates,
this is mostly in the interest of compatibility with sound files created with other hardware
products. From a practical standpoint, the 10435 recording rate will perform just fine for most
voice recordings, and for music, or sounds with a lot of high frequencies, a rate of 16398, or

HyperStudio Sound Shop

perhaps 22824, will work well. If you limit yourself to using just these rates, you'll have much
more flexibility in combining parts of one sample with another.

Clear: The Clear function is a lot like a Cut, except that the clipboard memory is not used. For
example, suppose you had the word “three" on the clipboard, but wanted to completely delete
the word "two" from the middle of the sample without losing the word "three". By selecting the
sound for "two" and choosing Clear, the selected portion would be removed from the wave-
form, and the sound "three" would still be on the clipboard. Try it now to see how Clear works.
Clear the word "two" from your sample, and then choose Play Clipboard 1o verify that the

word "three" is still there.

Play Clipboard: This plays whatever is on the clipboard from the last Cut or Copy operation.
This is useful to hear exactly what you have captured on the clipboard before pasting it
somewhere else in the current sample, or even another sound file.

Clear Clipboard: This erases whatever is currently on the clipboard. The main use for this
would be in those cases where you wanted to absolutely maximize the amount of me

available for a subsequent operation, such as a long recording. This is most likely to only be of
use when the Maximum Memory option is in effect (see the Settings menu description later).

Tools

The Tools menu provides a number of additional editing functions that can produce interesting
effects, and help you create the best sample possible. In general, if no specific part of the
waveform is selected, then the action will be performed on the entire sample. On the other
hand, if you select just part of your sound sample, then only the selected part will be affected.
Let's see what each of these functions is used for.

Erase: [BE] This clears the selected part of the waveform back 1o zero (the center line). This
is used most often to erase just part of a sample. To see how this works, we'll record something
with a deliberate flaw, and then use the Erase command to remove it. First record the words
'Gflﬁ. two, three, four” again. However, this time, between the words "two" and "three”, tap the
microphone once with your fingertips.

When you play the recorded sound, you should hear our rather contrived "pop” between the
words "two" and "three”. You can see this in the waveform as a sharp spike in the middle of
the recording. Use the mouse to select just the spike. Verify you have our deliberate error in
the recording by using the Play button. Now choose the Erase function from the menu. The
selected part of the waveform will be erased back 10 the centerline, with the result that the
"pop” has been removed. This can be used when recording sounds from noisy sources, or in
those cases where you wanlt 1o remove just a portion of a series of sounds, but don't want to
change the length of the sample by using the Cut or Clear functions.
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Fade Up & Down: [BU & GD] Use this to taper the volume of a sound sample at the
beginning and end. Fade up starts the volume at zero, and ramps up to full volume over the
range you have selected. This would be used to edit a sample that had been "sliced”, for
example, from the middle of a longer sound. By doing a Fade Up at the beginning, your
sample will sound more natural. Fade Down is just the opposite, and is used at the end of a
sample 1o fade out the sound. These effects can be used anywhere in a sample, not just at the
beginning and end.

Filter: [(3F] This is a subtle "smoothing” function that can take some of the background
“hiss” out of a noisy sample. To use it, you select the portion of the sound sample you want to
clean up, and then choose Filter. If nothing is selected, then the entire sample is filtered. You
may have 1o use the function several times o produce a very noticeable effect. On the other
hand, repeating the operation very many times will start to make the part of the sound you're
interested in sound "dull” or muffled. This function is unlikely to be needed on any recording
you do with the HyperStudio hardware, but is provided to help you with sound files you get
from other sources.

Layer: [3L] This is a very useful editing tool. It takes whaiever is on the clipboard, and adds
it 0 the existing sound at the selected point. With it, you can produce your own "echo” effect,
and also mix different sounds, With the Layer wol, you can take what is on the clipboard, and
mix it with the sound currently on the screen, starting at the comrent edit marker,

For example, you might have one recorded sound of falling rain, and ancther of thunder, and
want to combine them into one sound sample. You would first load your file of thunder, and
copy a section you like using the Copy function. Remember, you can use the mouse 10 select a
range, and then use Play to make sure it's what you wanL

Once the thunder sound was on the clipboard, you would open your Rain sample file. What
you want to do is to add the thunder "in the background”, so to speak. Put a marker bar about
halfway in the Rain sample (by positioning, then clicking the mouse), and then choose Layer
from the Tools menu. The sound on the clipboard will then be combined with the rain sample,
starting at your marker point. Layer literally adds the two waveforms together, producing the
mixed sound that you want.

You can also use Layer 1o manually produce an echo effect. First, make a fresh recording now
of the familiar "one, two, three, four” test pattern. You can record it right over whatever might
already be in memory (if anything). Recording always compleiely erases whatever was in
memory.

Now, select the word "three" from the waveform, and also, look at the Editor Status box just to
the left of the Record button, and note where your selection starts. Choose Copy to copy the
word "three” 1o the clipboard. Now click once with the mouse slightly o the right of the
beginning of where you selected the word "three” a moment ago. For example, if your selec-
tion started at 21000, try putting the marker bar at 22000 before you choose Layer. The result-
ing effect should be a kind of "hollow" sounding echo. Now put the marker bar halfway
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through the word "three”, and choose Layer again. This time the resulting sound should be a
more "classic” echo.

Layering will also work better with higher record/playback rates. At lower rates, you may have
problems with the combined sound actually being quieter than the original files. Higher sample
rates avoid this problem, though obviously at the cost of a greater use of memory. Our advice
is to try o get the effect you want at a lower rate first, and then increase the rate only if neces-
sary.

Important!! If you are layering a sound that was copied from a different file, you will get
strange results if the playback rates in each file are different. See the discussion in Copy
& Paste for more information on this.

Redraw: [CJW - "Waveform"] This is used to redraw either a selected portion of the wave-
form, or to restore the original view after viewing just a portion. To see how this works, select
just the word "one" on the screen, and then select Redraw.,

Now press the Play button. Notice that just the word "one" plays, and that the screen is now
blue. With the Redraw command, you have "zoomed in" on just the part of the waveform that
plays the word "one”. Now select just the first half of the waveform for one. (Highlighting will
now be & light-colored region). Choose Redraw again, and then Play.

You should now have just the "wa" sound in "one”. With Redraw, you can select, and reselect
smaller portions of the waveform as many times as you wish until the window shows each
individual "bump" in the wave that creates your sound. Of course, very small samples will
reach the point where an audible sound may not even be heard, since you are dealing with a
sample that may be as small as a few hundredths of a second. The smallest sample that Redraw
will show is 256 data points from one side of the waveform window 1o the other.

To restore the original waveform display, just choose Redraw without selecting a region.
Choose Redraw now to restore the display.

Reverse: [CB - "Backwards"] This function reverses the selected portion of the waveform, or
the entire sample if nothing is selected. It is mostly of novelty value, although if your favorite
local radio station is having a contest to recognize popular songs played backwards, it may
represent some real income potential to you!

Stutter: [T - "Tripping off the tongue” Oh, all right, then you think of a better way to
remember it!] This is commonly called the "Max Headroom Effect”, since becoming popular-
ized by that once-famous television personality (yes, fame is fleeting!), It has the effect of
doing copy and then multiple paste of the selected sample. Try it on the beginning the word
"two". You want 1o select just the "t" sound of the word "two". Remember, you can choose
Play while a portion is selected 1o see if you have just the part you wanL

Once you've selected the part you want, choose Stutter from the Tools menu. Now click on the
Play button to hear the effect
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Sound Menu

This menu gives you the equivalent of the Play and Record butions, and also offers an aliema-
tive Record mode which can be useful in some situations.

Stop and Play: [H - "Halt" & (OP] These are equivalent to the screen butions. The impor-
tant thing to notice here is that there are keyboard equivalents of the Play and Stop buttons,
namely Apple-P and Apple-H. If you're doing a lot of repeated operations, it can more conven-
ient 1o use the keyboard, rather than the mouse, 10 operate the record and playback functions.

It is also important to notice, although it has been mentioned earlier, that the Play bution only
plays the selected part of the waveform. This is very useful when you are about to do a copy or
a paste, because you can make sure you have selected just the portion you want. In addition,
there will be times when you want to concentrate on just a portion of a recording, and this
makes it possible, without having to listen to the whole thing each time.

Record Modes: [CGR & (OM - "Mode"] Like Play, Stop, and other Sound Shop commands,
the Record function also has a keyboard equivalent, Apple-R. However, the actual way in
which the recording is done can be one of two different methods. In the usual, or defaulr mode
(Record Mode 1), the recording starts as soon as you press the Record button. The recording
stops when you either a) press the Return (or any other) key, or b) when the recording has used
up all available memory.

For short sounds, this works preuty well. If you are recording a sound off a sound effects tape,
for example, there is most likely going to be a space at the beginning where you start the
player going, and probably a bit of a space at the end where you let the tape play for a while
before pressing the Stop button in Sound Shop. However, both "dead areas” in your recording
are easily edited out by using the Cut or Clear editing functions.

But what about those cases where there are a lot of continuous sounds, (perhaps part of a cat
fight outside your window) and you want o get just the right part of the sample. When you
start the record process, it will stop on its own in a relatively short time, and you could miss
your perfect yowl just as you were restarting the recording for the fourth time.

Record Mode 2 is the solution to just this problem. Record Mode 2 is a continuous recording
operation that never stops until you press the Return (or any other) key. When you do stop the
recording, the last sounds you heard will be at the end of your sample, and you'll have how-
ever many seconds before that as are indicated in the Buffer Stas window. Al that point, you
will probably want to Cut or Clear most of the sound at the beginning of the sample to get just
the part you want as the file to save.

To tell Sound Shop you want to use Record Mode 2, just select Record Mode in the Sound
Menu. You'll be presented with a dialog box that lets you choose between the two recording
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modes. The current recording mode is indicated by which Record Mode is highlighted in the
gﬂum:l Menu, and will remain in effect until you either change the mode, or you quit the Sound
op.

Selected Record: Although not a specific menu item, this function can come in very handy. If
you select just a portion of your sample, and then choose Record, Sound Shop will replace just
the selected part with the new recorded sample. You can use this to "patch” a sound sample if
you wish. Note that this simply replaces the selected portion, and does not lengthen or shorten
the selected area. This means that if you patch-record a shorter sample than the selected area,
any area not recorded over will retain whatever sound was there. On the other hand, if you
leave the record mode on for a period longer than the selected area, the record mode will
automatically stop and you will not record anything afier that point.

Although the selected record function can be handy in some situations, the alternative method
is 10 use the copy and paste editing functions with sounds recorded in their own files, and to
merge the sounds at your leisure.

Important: Noie that Recording a new sound will always clear the clipboard,

Settings Menu

;I‘l‘ﬁs menu allows you to set and reset various Sound Shop parameters. The options are as
Ollows:

Current File: Use this to restore the sample size and Playback Rates to their original values.

Startup Defaults: Choosing this sets the sample length to approximately 2/3 of the total free
memory in the sysiem, and restores the Record & Playback Rates to the startup values.

Maximum Memory: To allow working room for the Clipboard, the Sound Shop normally
only allows you to use about 2/3 of the available memory to record a sound. If, for some
reason, you require the maximum amount of memory 1o record a sound, or edit a large file,
choosing this function will set the available memory to the maximum size.

Disable/Enable Cautions: Usually the Sound Shop tries to remind you about the conse-
quences of such actions as a layer or clear operation where the action cannot be undone.
However, if you would rather take things in your own hands, and not have to bother with the
occasional reminder messages, choosing Disable Cautions will temporarily disable this func-
tion. You will still be prompted when loading a new file, with a reminder if you have not saved
an altered file, or you've made a new recording.

Choosing Enable Cautions (alternate menu item in this position) will restore the normal
operation of the reminder messages.
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Status Displays

As you have no doubt already noticed, the Sound Shop screen display includes the display of
some important numbers concerning your recorded sound. These are as follows:

Memory Status: This indicates the total amount of system memory available for the record-
ing of a sound. In the example screen, a total of 1297664 bytes. At a given record rate, this
corresponds to a specific amount of recording time (124 seconds in this example). Changing
the slider bar in the Record Rate control will change the maximum record time displayed for
the current amount of available memory.

o fik fdit Tosls Sound Settings

WEWBRY ETRTUS
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This box also displays the amount of memory currenily used by the clipboard when a sound
file is in memory. Remember thal your sound sample and the clipboard share a common
amount of available memory, and that increasing the size of one decreases the amount of
available memory for the other.

Buffer Status: At startup, this indicates the amount of memory available for loading a file, or
recording a sound. It also translates this into a length in seconds for a recording or loaded
sound file. If you have already loaded a file, or made a recording, this will show the amount of
memory used for that sample. The Record time, in that case will still indicate the maximum
time available, but the Play time value will show you the actual time represented by your
recording.

The Play time shown also depends on the playback rate specified. The playback rate is con-
trolled by the Playback Rate slider control below the Buffer Status window.

If you have anything on the clipboard, the play time of the clipboard data is also indicated in
this box.
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Editor Status: This window indicates the magnitude of the sound wave at the point currently
selected. This is useful for cutting, copying and pasting sound segments from one point in the

file to another. Try the select process now by positioning the mouse in the sound wave display
window. Now hold down the mouse button while you drag the mouse to one side or the other.
Note that the area selected is highlighted, and that the Editor Status box shows the magnitude

of the sound wave at the current selection point.

Record Threshold: When you start the recording process, you may want the system to wait
until rhere_:s an actual sound to start recording. Since there is always some degree of back-
ground noise in the system, the threshold setting allows you to specify what initial value of an
incoming sound should trigger the start of the recording process. When a non-zero Threshold
value is used, the screen border will turn green while Sound Shop waits for a sufficiently loud
sound 1o start recording. When the recording process starts, the screen border will tum red.

Play Volume: This lets you set the playback volume of a sound sample. Values that are too
large may "overdrive" your speaker system, so iry to use a value that gives the best sound. The
exact value may depend on the speaker and/or amplifier system you are using,

Echo Delay: This control is used for creating special "echo” effects with your sound sample.
See the description earlier for details. % i

Repeat Count: This value determines how many repeated plays of the selected sound sample
w!l.'l be played. You can use the repeat count to create an apparently longer sound effect,
without using the large amount of memory that would otherwise be required.
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Sight 'n Sound

Sight 'n Sound is a fun utility provided so that you can change the startup process of your
Apple TIGS to put a picture on the screen while the computer is starting up, and/or have a
sound you have recorded play as well.

In addition, for those programs that use the standard Apple "beep”, such as an Applesoft
BASIC program, or others, you can replace the "beep” sound with your own sound, such as
"oops!”, the sound of breaking glass, a pleasant "try again", or whatever you like.

Sight 'n Sound is easy to use. Just click on the Sight 'n Sound icon in the HyperStudio Home
Card, or launch it from the Finder, ProSel, the DeskTop, or any other program launcher.

When you use Sight 'n Sound, the title screen will appear. Let's take a look at each of the
options:

Startup picture: When you click on this, you will be presented with the standard file selec-
tion interface. Use the disk and open buttons as necessary to find the picture you want to use as
a startup picture. To try it now, you can use any of the graphics on the HyperStudio.Art disk.

Once you have selected your picture, another dialog box will appear with a miniature image of
the picture, and ask you if this is really the picture you want to use. If it's not, clicking on "No,
pick another” will take you back to the file selection interface. Assuming you've found the
picture you want, clicking on "Yes, install" takes you to the next step.

Now all you need to do is to tell Sight 'n Sound on which disk you want put the picture. You
can use your HyperStudio disk (a backup copy of the disk, that is), as a test disk if you wish.
Ordinarily, you'll want to insert a normal GS/OS disk in the drive. You can use Next Device to
bring up the name of each disk drive you have connected, or the Re-Check Device to re-
examine a disk drive afier you've put in a new disk.

When the name of the desired target disk is shown on the screen, click on the Install button to
complete the installation. If a startup picture already exists on that disk, you'll have the oppor-
tunity to cancel the operation, or continue anyway.

Note: There are actually two Sight 'n Sound programs on the HS.Sounds disk. SNS.320 adds
320-mode Super Hi-Res graphics 10 a disk; SN5.640 does the same for 640 mode grahics. The
graphics from the HS.An disk are all 640 mode graphics. Screens from PaintWorks Plus are
320 mode.

Startup Sound: This is similar 1o the startup picture function, except that it will put a Sound
Shop-recorded sound on your disk that will be played when the computer starts up.
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Selecting a sound is done Jnsl like any other file, except that after you have selected it, you'll
anet.peoppnrtumlywplny it 10 make sure you've got the sound you want. If it is, clicking on
Yes, ms!.n]l"mkcsymmﬂmmcdiskselacﬁondialngmmmwasusedwheni:mﬂinga

starlup picture,

Note: It‘yuursoundsmnpletakcslmgermplaymmme:imeinakcsymrctiskmmnup.ﬂae
end of the sample will be stopped prematurely as your actual startup application is loaded. The
um::.avm!able for a startup sound varies according to the type of disk drive you have, and what
s:;f:tfm;amlsun your disk, so some customizing of the startup sound may be desired for the best
effect.

Sgslem Beep: This is for replacing the usual "beep” in Applesoft BASIC and other programs
with a recorded sound of your choice. The process is identical to adding a Startup Sound, but
your custom sound will only be heard when the Apple IIGS system beep is used.

Removing Startup Files: Any or all of the files just added can be removed by simply using
the Remove buttons on the right of the Sight 'n Sound function box. In each case, all that is
displayed is a dialog box for selecting a disk. For each device, Sight 'n Sound will tell you
whether there is currently a startup file on that disk or not.

File Usage: Sight 'n Sound adds the following files in the System Setup folder of the target
ﬂ The System.Setup folder is located in the System folder present on any GSOS startup

For a Startup picture:

SNS.5P This is the program that actually loads the startup picture.
SNS.SP.PIC The picture to be loaded. e
For a Startup sound:
5NS.S5 This is the program that actually loads the startup sound.
SNS.SP.SND The sound to be loaded. Y
For a system beep:
SNS.SB This is the program that actually loads the system beep.
SNS.SB.SND The sound to be loaded.

The files SNS.SP, SNS.SS, and SND.SB must be on the disk in the same directory as the Sight
'n_Snund‘uultty for an installation to work properly. If the files are not found, then a message
will be displayed when the installation is attempted. The Sight 'n Sound utility does not have
10 be on your own disk for the startup functions to work.
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or ProSel, you can also get a longer display time of the picture, and a longer play time by the
sound, if you move the files SNS.SP and SNS.SS to the top of the Sysiem.Setup folder.
SNS.SP cannot be moved to a position before CDEV.Init in the System.Setup folder.

Sound Browser

The Sound Browser is a utility for quickly looking (listening?) through a number of sound files
on a disk. It is very simple to use, and just presents the usual file selection interface to choose

the files you're interested in. Only Sound Shop-compatible files are displayed. After a md is
loaded, it is immediately played. After playing, you can then choose another sound to listen to.

Sim:csunusou:ﬂsnmplcsmnbcraﬂ:erlmg.mu-eisalsuas]jdu;nnuql:hnﬂmymﬂadjusi
memomtofe-nchsuundﬁlnwbemadinmdphyed.mm_umbqwge
through a large number of samples when you're looking for something in particular.

When you're done browsing, just click on Cancel to return to the HyperStudio Home Card,
Finder, or any other program selector.

e i pr—
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One of the traps in looking at example stacks done with HyperStudio is the temptation to
immediately classify, and thereby limit, your impression of possible applications in terms of
what you have already seen. HyperStudio can be used to create a fantastically wide variety of
software. Here are just a few more ideas on possible stacks that anyone could create:

» Child's ABC Book. Imagine a stack created of screens with the letters of the alphabet, and
objects like an Apple, Bear, Clown, etc. When the child clicks on a screen image, they hear
the phrase "A is for Apple”, eic. A variation is to have the stack immediately play a phrase,
and then have the child click on the image needed to maich the verbal prompt. The stack
would then respond with a happy face, or try again voice before going on 1o the next card.

* Interactive Adventure Story. In this setup, a card could have, for example, a castle with
two doors. Depending on which door (invisible button) the user clicks on, the story would
branch to alternative story plots. You could create a wide variety of plot variations within a
"story-stack”.

* Repair Guide. This stack starts with an picture of a camera, bicycle, copier, faucet, motor-
cycle, carburetor, or anything else that you have ever seen a repair guide on. From there,
clicking on different parts of the picture leads you through disassembling, repairing, and re-
assembling the device.

* Office Building/Personnel Guide. This stack would offer a directory to different offices
and personnel in a business. Click on different departments to get a map of how to get to a
given office. See an organizational chart of personnel. By clicking on a position in the chart,
you get a picture of the person, an introduction in their own voice, information on their duties,
services provided, etc.

* Interactive Tests. For school or business, you can use HyperStudio's ability to use its
buttons as "answers" in a test to creale interactive quizzes, tests, elc.  When a testing stack is
completed, HyperStudio writes a text file out o disk that has a list of the "answers" (buttons)
chosen on each card, the stack name, student name and date. Other programs can then access
this information as needed.

* Introduction to Classical Music. This stack plays passages of classical music, and asks the
user 1o identify the composer and/or name,

* Family Tree. Geneology is an area that is very difficult to implement on a classic-style
database. By contrast, HyperStudio lets you create a card for each family member, putting a
picture of the person, details of their life, even a voice sample, on each card, The cards are
then linked according to relationships as needed. Cards can also branch to general information
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such as the origin of the family name, information on the country of origin, interesting stories
or incidents, elc.

« United States or World Database: Information on all 50 US States or World. Additional
Quiz format that has you identify a state by clicking on the correct spot on a map in response
to questions, facts & trivia.

= Animals of Africa: Learn about the wildlife of Africa. Click on a country in a map of the
continent, and then go on a safari, exploring the animal life of the region. Hear lions roar, the
rumble of a thunderstorm on the savannah, even the rushing waters of Victoria Falls!

= Knowing the Masters - Art: Leamn to identify classical works of art by matching a picture
with the title of the work and the artist.

* Dynamic Flow Chart Demo: Here's a novel idea: Make each card in a stack a step in a
classic program flowchart. As the user clicks on Yes/No choices, they move through the
"program” (the stack).

These are just a few of the possible applications of HyperStudio. There are many, many more.
In fact, a good source of ideas is to just walk into any bookstore, and look at the variety of
subjects and presentations on the shelves. A large number of the things you currently see in
printed form can be done in hypermedia in a totally new and refreshing way.

HyperStudio Catalog

Roger Wagner Publishing, Inc. is putting together a catalog of public domain and commer-
cially sold HyperSwdio stacks. We also hope to include other items that would be of use to
HyperStudio owners, such as video digitizers, scanners, sound effecis tapes, records, CDs,
software utilities, and other products. This catalog will be sent free to all registered
HyperSiudio owners.

Mailing in your registration card is the only way we have of knowing you are a HyperStudio
user to send you the catalog, and notices of future updates and improvements to the software.
If you haven't already done so, please mail the registration card today.

If you have created stacks that you think would be of interest to others, we would also like to
hear from you. Write or call Roger Wagner Publishing, Inc. at the address and phone number
listed at the front of this manual.
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The dt._:scriph:cq in the manual of how animation works is accurate, but it's easy 1o overlook
how simple it is to create an effective animation in a stack you are creating. The following
mini-tutorial is provided w help you experiment with creating animations in your own stacks.

Blinking Objects (Names, arrows, etc.):

The first example will be of how to create a blinking item on the screen when a button is
press;._d* This could be a name, an arrow pointing to a location, or any other alternating
graphic,

To try this out, choose New Stack from the File menu, and then use the Add Clip-art function
(also in the File menu) to bring up the file Output, located on the HS.Art disk. In the upper-left
corner of the screen for the Output file is a picture of a printer. Use the square selector tool to
draw a rectangle around the printer image, and click on "Ok" at the top of the screen. The
image of the printer will appear on the screen. Use the mouse to position the image in the
upper-left part of the screen, and click outside the image to drop it in place,

We'll suppose that this is the first card of a stack about computer terms. Suppose you wanted
the user 1o click on the printer, and then hear the spoken word "printer”, and also see the word
flash momentarily on the screen.

To do this, we'll attach a sound and an animation to an invisible button over the printer image.
The animation will consist of two frames, one each with anu without the word "printer”, We'll
then repeat this animation sequence three times.

Before the animation can be connected to a button, however, the sequence must first be cre-
ated. An animation sequence consists of a series of graphics screens, with some difference
between each successive frame. Viewing the frames rapidly creates the animation effect. For
a p#ﬁng object, the sequence is very simple: One frame with the object, a second frame
without.

To create the first frame, select the "T" icon in the Tools menu (the paint text tool). Click the
mouse on the screen somewhat below the printer image, and type the word "Printer”, This will
be our first frame of the animation. Go to the File menu, choose Save Screen, and save the
screen under the name Printer.1,

Now, use the eraser tool 1o erase the word "Printer”. The screen with the word gone will be the
second frame of our animation. Go back to the File menu, choose Save Screen, and save the
screen under the name Printer.2. Now it's time to create the button that will trigger the
animation,
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Go to the Objects menu, and choose Add a Button. Choose the invisible button style, and click
"Ok". It is not necessary to enter a name for an invisible button. Afier an optional instruc-
tional dialog box appears (if this is the first button you've added after starting up HyperStudio),
the rectangle for an invisible button will appear on the screen. Use the mouse to drag the
rectangle over the image of the printer, and to resize it to something that completely covers the
printer. It is all right if the rectangle is larger than the printer image.

When the invisible button rectangle is positioned, click outside the rectangle to drop it in
position, Now click on Play a Sound, and choose Record Now. When the tape recorder
appears, click on the Record button, and say "This is a printer”, then press a key to stop the
recording. Click on the Play button to verify you've got a good recording. You can also adjust
the volume here to a comfortable level. When the sound is set up correctly, click on "Done”.

Note: If you hit a key to stop the recording, and do it loudly, the "click” of the keyboard will
be included at the end of your recording. If you hear a click at the end of a recorded sound, iry
recording again, and press a key to stop the recording.

When the Button Actions menu reappears, click on Activate Animation. When the list of files
appears, choose Printer.1 to specify this animation sequence. A window will appear, probably
with the image of the printer in it. Use the mouse 0 drag the hand cursor to move the printer
image, and bring the word "Printer” into view. Move the word "Printer” into the upper-left
corner of the animation rectangle. Now resize the rectangle to a smaller size, to neatly frame
the word "Printer”, but try not to make the rectangle too small. You just want to create an
image you can work with.

MNow use the mouse to drag the frame of the animation rectangle, and place it under the image
of the printer. Click outside the animation rectangle to drop it in position. A message will
appear telling you HyperStudio is generating the animation, and then the Button Actions dialog
will appear again. Set a Rate of 45, and a Repeat Count of 3, then click on Done.

Now let's try it out! Click on the image of the printer. You should hear the phrase “This is a
printer”, and see the word "Printer” blink three times.

It's that easy! Blinking objects are the easiest to create, because you only need two frames. If
you want the object to be left on the screen when the animation is done, make sure the last
frame of your animation has the object visible. In that case, you would make the first frame
the "empty"” picture (no word "Printer"), and the second frame would have the word visible.
Then, when you create the animation, click on Printer.2. This will bring up the second frame
in the animation window, so you can still place the word "Printer”. However, this time, the
word "Printer” will be visible when the animation ends, and thus left on the screen for the user.

This technique could be used for a blinking arrow, or wamning-light effect.
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Important Points:

1) Wha'tevm' filename you click on when selecting an animation is the one that will be loaded.
Dc-n'lcluckonaﬁanmwhm:menhjmtisnmvisible,becaumyouwm'lbcableMphceh
where you want it (since it won't be there!).

2) HyperSwmdio always uses the entire available sequence from Filename.1 to Filename.999,
regardless of which file you click on.

3) The last frame of an animation is always left on the screen. If you want the object to stay
on the screen, make sure it's visible in the last frame, If you want the object to disappear, make
sure it's erased from your last frame.

4) Animation files do not have to be continuously numbered, or even begin with any particular
number. You could have the files Printer.20, Printer.25, and Printer.99, for example.

Moving Objects:

In this next example, let's create a simple sequence of a plane flying across the screen, and
introduce the idea of a stack-based "work file" for an animation.

Choose New Stack from the File menu. Go to the File menu again, and choose Add Clip-Art.
From the HS.Art disk, open the file Output. Near the right edge of the screen, you'll see an
image of a jet airplane. Move the slider bar at the bottom of the window until the airplane is
wotally visible, and then use the mouse to draw a rectangle around the airplane. Click on Ok
when you've selected the correct area. Now position the airplane at the left side of the screen,
and click outside to drop it. If you've accidentally got any extra graphic bits on the screen, you
can use the eraser tool to erase them.

The idea in creating this animation will be to create a series of cards in a stack that has the
airplane moving to the left a certain amount in each successive card. This stack will only be
used to create and edit the animation, and not for any other purpose. As such, it becomes an
animation "work file",

Go to the Apple menu, select Preferences, and make sure that Erase background on new card is
not checked, and that Show card number in menu bar is checked. We will let HyperStudio

automatically duplicate the background for each new card in the animation. Click on OK in
the Preferences dialog box.

Pull down the Tools menu, and choose the selector tool (the square dotted line icon). This is in
preparation for selecting graphics in a moment. Press Apple-N (for New Card). The number at
the top of the screen will change to "2". You are now on the second card in this stack. Use the
mouse 10 draw a rectangle around the airplane, and drag the image about 1" to the left. Press
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Apple-N again 1o create the third card. Again, select the airplane image, and drag another 1" to
the left. Repeat this process two more times until you have six cards, each with the airplane in
a different position.

You now have a stack of six cards with the frames for an animation. You can hold down the
Apple-> key to move through the cards in the stack and get an idea of how your animation will
look. Now, let's save the frames as graphic screens for use by HyperStudio's animation
feature.

Go to the Move menu, and select First Card. Now go to the File menu, and choose Save
Screen. Make sure you have a disk with at least 80K free on it. The default name in the Save
Screen dialog box should be New.Pic.01. Normally, you would replace this with a name of
your own, but for the moment, this will work perfectly for saving a series of numbered graphic
screens. Press Return to accept this file name. When the save is complete and the screen
remums o card #1, press Apple-> (Next Card), and then choose Save Screen again. This time,
the default name will be New.Pic.02. Press Retum to accept. Again, go o the next card and
save that screen, and repeat until all six cards have been saved Lo disk. (If the Save Screen
doesn't begin with New.Pic.01, because you've already saved a screen earlier, don't worry.

You just want to save a numbered series of screens - the actual starting number doesn't matter.)

Now is a good time to save the stack itself. Choose Save Stack from the File menu, and save
the stack under the name Plane.Work. By keeping the file, you can go back later and make
changes to the animation sequence, without having 10 recreate the graphics.

Now, let's try out the animation. Choose New Stack from the File menu. Then, choose Add a
Button from the Objects menu, create a visible button called Test, and position it near the
bottom of the screen. Check "Activate animation...”, and when the file selection dialog ap-
pears, select New.Pic.0l. A white rectangle will appear in the middle of the screen. Use the
mouse (o drag the rectangle to the left side of the screen, then grab the handle on the left edge
of the rectangle, and resize the rectangle to be as roughly as wide as the screen. You probably
can't see the airplane, because it is out of view in the window. Move the mouse to inside the
rectangle, hold down the mouse button, and drag the mouse up until the plane is in view. The
size of the rectangle represents the animation area, and needs to have the full left-to-right area
available for the complete motion of the plane. Click outside the rectangle, and a dialog box
will appear telling you HyperStudio is creating the animation.

When the button Actions dialog box reappears, enter a Rate of 10, and a Repeat count of 2,
then click on Done. Now, test the animation by clicking on the Test bution. The plane should
fly two times from right to left across the screen. If you didn't want the plane image 1o be left
on the screen at the end of the animation, you would leave a blank frame at the end of the
animation sequence, as card #7 in the Plane.Work file, and saved as New.Pic.07 on disk.
Remember, it is not necessary that the picture files you save begin with "1", or that they be
continnously numbered. You can always use any name you wish for the animation files, as
long as they end in some number, and all share the same name as the beginning of the file-
name.
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The following information is provided to help you get the best resulis possible when recording
and playing back sounds using the Sound Shop and HyperStdio software.

All of the smmds you hear on the HS.Demo and HS.Sounds disks were recorded using the
HyperStudio digitizer. The voice in Saturday and Spanish were recorded with the HyperStudio
microphone. All others were recorded from casseltes, using an inexpensive walkman-style
cassette player.

You should be aware that there is some variation in individual Apple IIGS computers, so your
computer may be slightly quieter or noisier when recording sounds than others. However, with
a little understanding of the things that effect the overall quality of a recorded sound, you
should be able o get the best possible performance from your machine,

Avoiding Electrical Interference

The biggest source of problems in recording sounds is the electrical “noise” that is inherent in
the computer. This is not noise that you can normally hear, but when the digitizer records a
sound by converting it inio electrical signals, the electrical activity in the computer and the
surrounding environment can be picked up, and mixed into what you are trying to record.

The HyperSmdio digitizer minimizes this problem by nor plugging into one of the slots in the
computer. Being physically connected to a slot is the surest way to transmit the electrical noise
from the computer into a digitizing card.

If you are having problems with excessive noise in your recordings, consider each of the
following, and see if any of these apply to your situation.

Note: “Excessive noise” can be detected by doing a “smothered mike” test. This consists of
holding your hand over the microphone, while you record about 5 seconds of silence in Sound
Shop. When the sound wave is drawn, examine the display. If the “bumps” in the display are
more l.hnn +/- 3 units in value (click on a given point and lock at the Level value in the right-
hand window), or they appear in large quantity at a regular frequency, then you may have noise
in the system that can be eliminated. If you are concerned about excessive noise in your
system, and are writing us about the problem, sending a disk with sample recordings will help
us a great deal. Record one sample with the smothered mike test, and one sample of your
voice.

Do keep in mind that even at best, there will always be a small amount of background noise in
the quiet passages of a recording. This is normal for the system. Even a tape player, when the
volume is turned up, has a background hiss.
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Monitor - The Apple [IGS nmnitnrisnwongsnmpfeiac!ﬁcalmise. ‘.[f:hethemir:m
phone is closer than about 12" while recording, you will get interference from t!'m monitor.
Avoid this by just being careful not to lean in towards the monitor while recording, or draping
the microphone wire over the top of your monitor.

Fluorescent Desk Lamps - Flourescent desk lamps are also a strong source. Don’t record
with the microphone or its cable directly beneath (closer than 127) a disk lamp.

OtherSoundCuds-TthywShﬂiodigiﬁmisquimmmimmbethd:mmitplug
into the internal slots in the computer. Howevcnifyoumusingthe“piggy-bmk option to
connect another sound card to the HyperStudio digitizer, you probably will get more noise than
if no card was connected. This is because the electrical noise can now flow from the slot
connector, into the other card, and then into the HyperStudio digiﬁw._Unfmmmmly.ﬂm
isn't any way around this problem other than not connecting the offending sound card to the
HyperSmdio digitizer.

The other altemnative is that, if you do have another soundcard.yoapmbablycanusa'g!m
record sounds in both Sound Shop and HyperStudio, without “equiring the H;E-pg'Smdm
digitizer to be present at all. Obviously, the sound input quality will then be limited by the
quality of your own digitizer card.

Fans - The Apple 1IGS internal fan from Apple Computer should not cause a problem when
attached to the HyperStudio digitizer. However, there are some inexpensive third-party
models that can cause problems. External fan units, such as the Kensington System Saver GS,
or the MDIdeas/Applied Engineering Conserver should not cause any problems, since their fan
power supply is separate from the fan power line inside the Apple IIGS.

If you do have a problem with a third-party internal fan, mgmis no easy solution, other than to
replace the fan with another unit. However, if you are feeling a little adventurous, or want an
absolutely perfect power source for the HyperStudio digitizer card, you can buy a 9-volt
battery clip from Radio Shack, or any other electronics parts suppty house, and use a 9_m_lt
battery to power the digitizer card. You can literally push the wires from the battery clip into
the 2-wire plug on the digitizer card that would otherwise plug into the fan plug inside the
computer. Be sure, however, that you get the polarity right. The red (positive) wire from the
battery clip should match the red wire in the digitizer card plug.

Placement of the Ribbon Cable - Although usually a minor factor, you can try running the
ribbon cable from the HyperStudio digitizer over the top of any peripheral cards in the com-
puter, rather than under them. This will keep the ribbon cable away from the motherboard
itself, which is a potential source of electrical noise. However, be aware that it is possible that
some particular card will have a component mounted near the top of the card that will be a
stronger source of interference than the computer itself. Placement of the ribbon cable is
simply one more option for you to experiment with.
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Other cables - In general, you should try to keep the microphone from being entangled in
other cables at the back of your computer, such as disk drive cables, printer cables, etc. Try to

keep the microphone cable running in a relatively direct path from the back of the computer to
your work area.

Power Supply - Although rare, the internal power supply can also be a source of some noise.
After you've tried the other options, you can try moving the digitizer card away from the
power supply, into one of the other cutouts, if you don’t have t0o many other cards in other
slots,

Improving the Input Quality

To get the best sound possible in HyperStudio, you can also take certain steps to improve the
overall quality of the sound input to the HyperStudio digitizer card.

Microphone Technique - When speaking into the microphone, be sure to hold the micro-
phone right up to your mouth, and speak clearly and firmly. It is not at all necessary to shout,
but you shouldn’t be timid, either. Sound Shop is the best place to practice with recording
sounds, since you can see an actual display of the sounds you are recording. You want the
waveform displayed in Sound Shop to approach the top and bottom of the window in places,
without actually going out of range. A recording that does not produce a good waveform will
sound noisier than one done with sufficient volume. Also, remember that if the microphone is
12" away from you when you speak, this will be 100 far for HyperStudio or Sound Shop to pick
up any kind of a strong sound input at all.

Other Microphones - Although the microphone in the HyperStudio package is quite sufficient
for casual use, other microphones may give better results. The simplest improvement is to use
a condenser microphone. These cost approximately $15 from places like Radio Shack. How-
ever, you should also realize the improvement is unlikely to be overwhelming. In very unsci-
entific terms, we rate better microphones as giving about a 10-20% improvement in the overall
quality of recordings.

Signal-to-Noise Ratio - This is a term that refers to how strong your recorded sound is com-
pared to the always-present electrical noise in any recording system. If you are recording with
& quiet voice or input source and/or playing back at a large (12-15) playback volume level,
then background noise will be most noticable, and very difficult to eliminate, If you can get a
good strong waveform in Sound Shop when you record (90% deflection in the window at the
high spots), then your input will overshadow any background noise. In addition, if yOu can use
an external speaker with a volume control that will let you play back sounds with a playback
volume of 6-8, then the background noise will be minimal compared to your recording. Re-
member, almost every recording will have quiet gaps between words, musical passages, or
other sounds in the recording, and it is in these spots that the background noise will be most
noticeable. If the playback volume is at the high end (12-15), then this background noise is
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amplified as well. Again, try to make strong recordings, and ideally, use a medium playback
volume level.

Tape Player vs. Microphone - You may get better results for some recordings by recording
first into a standard tape player, and then recording in Sound Shop from the tape player. This
is because you can control the volume in the output from the tape player, and and the recording
situation is a “closed system”, i.e., no outside noise.

It it certainly true that for digitizing sound effects, music, etc., you should definitely record
direct from the tape player, and not try to hold the microphone next to a speaker while the tape
plays.

Battery Tape Players - Although you might think an expensive tape deck would be the best
source when recording music, sound effects, etc., we recommend you use a battery-powered
tape player. 110v units often transmit electrical noise to the digitizer card. A battery-powered
unit is more likely to give you a good clean input sound.

Improving the Output Quality

The sound output quality of the Apple IIGS is almost entirely a function of how good the
speaker attached to it is. You should, of course, avoid entangling the cable going to the
optional HyperStudio speaker with disk drive cables, or other wires that are a source of inter-
ference.

The HyperStudio speaker will give a substantial improvement over the GS built-in speaker.
Powered speakers, such as the Yamaha DM-01 model (our favorite), will give the best per-
formance. You cannot hook up standard sterco speakers to the computer, since an amplifier of
some sort is required. You may also wish 1o look into other suppliers of amplified speakers,
such as Radio Shack.

Sound Shop and HyperStudio do not currently support stereo sound in either recording or
playback, although this may change in future versions of the software. However, you can use
stereo output cards as the sound output channel in HyperStudio without any particular steps
being necessary.

What about other sound file formats?

When the HyperStudio project was started, we looked around for a standard sound file format
that would accomodate all the requiremenis for HyperStudio. The primary requirement was
that the user be able to load a sound file stored on disk, and play it immediately without
resetting any parameters. This requires that values for volume, playback rate, echo delay,
repeat count, etc. all be stored in the sound file on disk.
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Unfortunately, no file standard currently exists (other than the HyperStudio/Sound Shop file
format) that accomodates all these requirements, and also provides for compressed sound files.

For that reason, Sound Shop and HyperStudio use a specific type of sound file, registered as an
official file type with Apple Computer, that contains all the necessary information. HyperStu-
dio can only directly import this type of sound file. If you have sound files from other sources,
you can use these sounds by first loading them into Sound Shop, and then resaving them in the
HyperStudio/Sound Shop file type.

In Sound Shop, you should be able to load sound files recorded with MDIdeas, FutureSound,
Sonic Blaster, Sound Studio and other programs. Sound Shop does not currently load com-
pressed sound files, although this is also expected to be handled in a future version.

If you have access to a modem service such as GENIE, CompuServe, or America Online, you
can also download digitized sounds for use in Sound Shop. Macintosh sound files will also
work in most cases when loaded into Sound Shop. If you have a Macintosh computer, and the
utility AFE (Apple File Exchange), uncompressed B-bit sounds recorded in MacRecorder, or

other digitizers, can also be converied to a ProDOS disk with the AFE utility, and then loaded
into Sound Shop.

Once loadnd you may have to set the volume, playback rate, etc. to get the sound just the way
you want it. When saved and reloaded into Sound Shop or HyperStudio, the sound will then
play perfectly every time.

Sound Shop and HyperStudio do not currently support MIDI music files, or other synthesized
note sequences, such as those produced by Music Studio, Music Construction Set, Diversi-
Tune, or other programs that do not use digitized sounds. This may also be addressed to some
degree in future versions of HyperStudio.
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Appendix D: Hard Disk Installation

Installing HyperStudio on a hard disk is very easy. The most direct way is to create a folder on
your hard disk named HyperStudio, and copy all the files from the disks HS.Demo,
HS.Sounds, and HS.Art to the folder. From the HyperStudio disk, copy only the files Hyper-
Studio, HS.TD, and Home.5Stack.

Your hard disk must be set up to use GSOS 5.0.2 or later. If you'll be using the Video Overlay
Card, you should also have installed Tool033 (Tools folder) and Apple IIVOC.Init
(System.Setup folder).

Once in the HyperStudio folder, HyperStudio can be launched by double-clicking on either
HyperStudio (from the Finder). Sound Shop can be launched by double-clicking on the Sound
Shop icon. If you have an Icon Editor, you can change the application pathname for the stack,
sound file, and other icons so that you can also launch HyperStudio or Sound shop by double-
clicking on the stack or sound file icons.

When HyperStudio brings up the Home Card, clicking on any of the icons should run all of the
demonstration stacks normally. Adding clip-art and sound files should also immediately
display the appropriate files as copied from the HS.Art and HS.Sounds disks.

Using Subdirectories: When using HyperStudio on a hard disk, you may want to organize the
files into subdirectories, such as creating the folders HS.Art, HS.Sounds, and perhaps even
individual folders for groups of stacks. This is fine, but you should realize the basic operating
"rules” with multiple direciories.

Last-used directories: When adding clip-art, sound files, loading stacks, etc. HyperStudio
remembers the last-used directory for various kinds of data. This makes it easy to go back to
the last directory you loaded something from. However, you should also remember that if you
put artwork, sounds, etc. in other directories, the first time you go to add clip-art, you will have
to use the Standard File interface 10 open the necessary folder. If you have a large number of
HyperStudio-related files, you may find that organizing subdirectories is both useful and
necessary.
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Manual Addendum & Index

The following pages contain information about features added to HyperStudio after the manual
was printed, additional tips on using the software, and an index for the HyperStudio manual.

Hard Disk Installation

The Home Stack now includes an icon (via the Applications button) called HyperStudio
Installer. This utility will automatically move all the appropriate files from the HyperSwdio
disks Hgoyuu’harddisk. Within the HyperStudio folder, it will also create the folders HS.An
and HS.Sounds.

When installing HyperStudio on a hard disk, a few changes will have Lo be made (0 the
Home.Stack for a few of the stack icons to work without prompting for the 3.5" disks. The
modification is required for those stacks located in subdirectories.

The stacks Jukebox, Art Library, Xcmd Info, Find Demo, and Video Overlay will be located in
the subdirectories Hs.Sounds, HS.Art, Xcmds, Xcmds/Find, and Xcmds/Video, respectively.

When you click on the icons for these stacks, HyperStudio will try to locate these stacks on the
original 3.5" disks. If you don't want 1o have o put the required disk in your drive when trying
these demos, delete the invisible buttons in the Home.Stack, and create neéw buttons that
connect to the comresponding stacks in their new location on your hard disk.

There is also a connection to another stack in the ArtLibrary stack. This invisible button is
over the lamp on the second card, and normally connects 1o the stack Test.320.Stack in the
Test.320 folder on the HS,Art disk. Delete the invisible button over the lamp, and create a new
one that connects 1o the Test.320.51ack in its location on your hard disk, which should be a
folder named Test.320 in the HS.Ant folder.

Here's a list of the stacks in the Home Card that you'll have to create new buttons for:

Stack New Location
Art Library HyperStudio/HS. Art/Art Library
Jukebox HyperSwudio/HS.Sounds/Tukebox

Find Demo HyperStudio/Xcmds/Find/Find. Demo
Xcemd Demo  HyperStudio/Xcmds/Exerciser/Xcmd.Demo.Stack
Video Overlay  HyperStudio/Xcmds/Video/VOC Demo




Remember, 10 delete an existing button, just choose the button tool (the "B" in an oval) from
the Tools menu, click on the button 1o be deleted, and then choose Clear Button from the Edit
menu (or just press the Delete key).

Tip: Whenever you get a dialog box asking to locate a particular file for a button you have
clicked on, remember 10 look at the top of the dialog box to see just what file HyperStudio was
looking for. This will help you create new buttons 1o go 1o the desired file,

Unidisk Drives (White): Important: the following information applies only to the older
Unidisk drives, which are white in color. There is no problem with the newer Apple 3.5 drives,
which are platinum (grey).

The Unidisk drives have a problem in that they don't "know” when a disk has been removed.
This leads to the following problem in HyperStudio, or any other deskiop style program on the
Apple IIGS:

You are working in HyperStudio, and for some reason, it prompts you o insert a needed 3,5"
disk. You already have another disk in the drive, so you remove it, insert the comrect disk, and
press Return. HyperStudio appears to not recognize the new disk, and asks you o insert it
again.

The problem is that, combined with the caching featre of GSOS, the computer still thinks the
original disk is in the 3.5" drive. The only solution here is to remove the original disk when
prompied, and then press Return before inserting the new disk. This forces GSOS 1o see that
the drive is now empty. Then insert the correct disk, and press Return again when it asks you a
second time for the needed disk.

A variation on this problem is when adding clip-art, loading or saving stacks, or any other
function that uses the Standard File Interface dialog box that is used in HyperStudio to select
file. If the disk you want to access is not in the drive when the dialog box comes up, replacing
the disk with the correct one and choosing the "Disk" button in the dialog box (or pressing the
TAB key) will not show the contents of the new disk. This is caused by the same problem:
GSOS doesn't know a new disk is in the drive. The only solution is to remove the first disk,
click on the "Disk" button so GSOS sees the disk is gone, then insert the new disk, and click
on "Disk" again so it recognizes the new disk. If you have other disk volumes online, such as a
hard disk, you may have to page through them each time to get back to your 3.5" drive.

New Feature Summary for
HyperStudio 2.1

This new version of HyperStudio has a number of improvements (o the software to make it an
even more powerful tool for you, while still keeping the software as easy 10 use as possible.
The following pages describe the specific changes to the software.

New Paint Tools:

« Stretch/shrink selected graphic areas (lasso & square selections). Afier selecting a

graphic item with the lasso or square selector tool (the dotted square in the Tools menu), place
the tip of the arrow cursor on the lower-right comer of the square (or an approximation of this
position if you're using the lasso). If you then hold down the Apple key while you drag the
mouse either up and to the left, or down and to the right, you'll see the graphic area re-sized as
you move the mouse. Because the original graphic is made up of individual points (pixels), the
resized graphic may show some distortion, but you should still find this a useful function.

« Easy straight lines ("constrained motion™). If you hold down the shift key before moving
the cursor, you'll notice that many paint tools (paint brush, eraser, pencil, line tool, etc.) will
auiomatically draw a perfectly horizontal or vertical line once the mouse starts moving. This
can be helpful when trying to erase a straight edge, as well. If you hold down the shift key

while using the rectangle or oval tool, you'll get a perfect square or circle.

+ Flip horizontal'vertical (Edit menu). When a graphic area is selected with the rectangle

or lasso, the functions "Flip horizontal” and "Flip vertical” in the Edit menu will be available.
These are useful when creating symmetric comers of your screen. For example, on the HS.Ant
disk is a file named "Dingbats” that includes some graphic elements that comrespond to a comer
of a screen. To the right of the graphic of the moon is an omamental comer that corresponds to
the upper-right comer of the screen. Use the mouse Lo draw a rectangle around this graphic, and
click on"OK", Drag the graphic o the upper-right corner of the screen and click outside the
graphic to drop it in place.

Now, you want 1o make a copy of the graphic to place in another comer. You could use copy
& paste, but an easy way to do this is to use the Option key as you start to drag the graphic to
make a copy. Reselect the graphic by dragging a rectangle around the graphic, then hold down
the Option key as you drag the rectangle to the lower-right comer. Once you start dragging the
graphic, you can release the Option key. Holding down the Option key as you start a drag
makes a copy of the selected regica.

When the graphic is positioned in the lower-right corner, go to the Edit menu, and choose Flip
Vertical. Use the mouse (o reposition the graphic to the exact place you want it (if it needs




adjustment). This time, don't click outside the graphic, but rather, hold down the Option key as
you drag the graphic to the lower-left corner. Holding down the Option key will automatically
paste the graphic in its current position before making the copy. When you've moved the
graphic to the lower-left corner, go to the Edit menu and choose Flip Horizontal. If the graphic
is where you want it, hold down the Option key again as you start 10 drag the copy 10 the upper-
left comer. In the upper-left comer, choose Flip Vertical once more from the Edit menu, make
sure the graphic is placed where you want it, and click outside the rectangle to drop it in place.

In general, the Flip commands just reverse the image of whatever area is selected. This function
can also be used to reverse the direction of arrows, direction of cars, airplanes, etc. Note: fringe
graphic bits, when horizontally flipped, may expand slightly giving fuzzy edges in some cases.
This effect happens when a graphic has an edge of a different color, for example, grey pixels on
the edge of a different color image. Removing edge colors will make graphics easier to flip, but
we should mention that there's no reason to arbitrarily remove edge colors from all your
graphics. In normal use, edge colors give a better overall appearance 1o an image.

= Draw Multiple (Options menu), Check this item in the Options menu to creale interesting
patecms. When this option is checked, rectangles, ovals and the line tool will leave a repeating
paiiem as the mouse is moved.

» Draw Centered (Options menu). Check this item o draw a circle or square centered around
a specific point. If you combine Multiple and Centered, you can get very inieresting geometric
patierns,

+ Color Replace (Options menu). This is a very useful new addition to the HyperStdio

paint iools. It is used io change every pixel in a given selected area from one color 1o another. If
no area has been selecied, the entire screen will be processed. In the Replace dialog box, you
can also choose "Exchange”. This will swap the two colors in the selected area. This can be
used to create an "inverted” image, and may also be of use when importing graphics from other
paint programs with the proper colors in the palette, but in a different order than the usual
HyperStudio palette.

+ 320 Mode Alert Box. To help determine when a 320-mode graphic is being imported,
HyperStudio examines every graphic file before loading it; if it appears to be a 320-mode
graphic, a dialog box now appears, telling you that the graphic may change colors when loaded.
Note: Some 640 graphics, when saved in certain paint programs, do not include paletie
information, and as such will display the 320-mode alert message even though they will be
imported with normal colors. The alert message only tells you the graphic may be a 320 mode
graphic. Some graphic files from the original 1.0 and 1.2 versions of HyperSwudio may trigger
this alert window. To "fix" them, simply lnad a graphic as a Background on a blank card, and
then immediately re-save the screen back with the Save Screen option in the HyperSwudio File
menu (use the same name o save with).

« Colors menu. The Colors menu can now be used 1o set the color of text, in not only the
paint text tool, but in text items and button labels as well. Simply choosing a color from the
Colors menu is now equivalent to using Set Text Color (in the Options menu). The Colors
menu can also be used to set the Background color. Simply hold down the Option key while
choosing a color, and this will set the current Background color. If a button has been selected
with the button tool, then holding down the Option key will change the bution color. If a text
item has been selected, then the Option key will set the entire Background color for the text
item. While entering text in a text item, you can use the Colors menu to set the current text or
Background color as you go. Choosing a color while the eraser ool is active sets the
Background color without having to hold down the Option key.

« "Dropping” Invisible buttons, Animation and "Add a Graphic Item"

rectangles. When placing an invisible button, full-screen animation window, or a graphic
itern, you can press Return instead of clicking outside the reclangle to drop the item. This is
provided for those situations where the rectangle takes up the entire screen, and there is no
"outside the rectangle” to click in!

Button and Text Item Colors & Styles

+ As mentioned in the discussion of the Colors menu, previously, buttons and text items now
use the current text and background color settings. These colors can be changed using either the
Colors menu (with or without the Option key) while an item is selected, or by using the Set
Text Color... or Background Color... functions in the Options menu. Text items now also
support multiple text styles. Buttons are still limited to Shaston 8, although different colored

text is supporied.

New Button Actions

« Next/Previous card are now relative motions. That is, in HS 2.0, use of Next and
Previous established an absolute link to card #n. "Next card” buttons like right-arrows couldn't
be copied to other cards (i.e., the copied button would still branch 1o card #n.). HS 2.1 now
uses the action Next and Previous as "current card +/- 1", which means arrow buttons can be
copied and pasted as desired with the expected result

» Home card action: This is equivalent to the user pressing Apple-H, The advantage of this
is that in earlier versions of HyperStudio, a link to the Home.Stack with the Connect to
Another Stack action linked the bution with an absolute pathname for the Home.Stack. This
limits return Lo a specific stack with a specific pathname (if another Home.Stack is not
available in the same directory as the active stack). HyperStudio now "remembers” the location
of the last Home.Stack, no matter what directory it was in. This will be more flexible for hard
disk usage, and also allows the concept of multiple Home.Stacks on the same disk, hard disk,
or network. For example, you could have three different Home.Stacks, designed for different




kinds of users, that all launched the same application stacks. By using the new Home action
(rather than the old absoluie link), each stack will automatically return to the Home.Stack that
called ir

Improvements to Editing

« Pasic Card inserts card after current card (not at end of stack). Note: The "Card #" that is
displayed in the menu bar is a card identifier number, not a "position indicator”. Since the cards
are numbered beginning with "1" as your create a stack, this ID number is pretty much the
same as the position number, However, as you start to cut and paste cards from different
stacks, or within the same stack, you'll find the ID numbers follow the cards. That is, if you
cut a card from the end of the stack (say, card #9), and paste it near the front, you may notice
that the card #s then count 1,9,2,3, etc. This does not effect the operation of your stack. Cards
ﬁnmmﬂgmnbemdwtmncardﬁamcu[nrpﬂsmd,becauseﬂtbuuonmmﬁumamaﬂbasedm
card ID #.

Miscellaneous Improvements

+ Move to Card # (Move menu). Use this to move to any card # in the current stack. Just
enter the card ID # (which may be different than its position in the stack) in the Move To dialog
box.

= Save screen now saves complete image (buttons, text items, etc.) depending on
setting of "Hide Items" in Options menu.

= Cosmetic changes to Sound Record/Playback screen. The "tape recorder” screen
now has a numbered scale by the volume slider to make it easy to use consistent volume
settings for a group of sounds. (File note: the file HS.TD is now obsolete, and is no longer
used by the HyperStudio program.)

= "Stack Info" shows usable free memory. The Stack Info dialog box now indicates

how much memory is still available o the stack you are building. This number is smaller than
the amount of raw free memory in the computer because it is only the largest single block of
memory that is useable for a stack. Check this dialog box occasionally as you build your stack
to stay aware of how much remaining room for expansion you have.

= Version compatibility: All stacks created with previous (versions 1.2 and 2.0) of
HyperStudio can be used with 2.1. Depending on the number of buttons and text fields in the
stack, however, there may be a delay due to the conversion process. During the conversion, the
cursor will change to an alternating "2.0/2.1" marker. Once converied, you can save the stack
back to disk, and subsequent loads will be at normal speed since no conversion will be needed.
Stacks created or saved from HyperStudio 2.1 are not backward-compatible with earlier versions
of HyperStudio (however, since the 2.1 update is being sent to all HyperStudio users, this
should not be a problem, and there is no reason to maintain earlier-version copies of any of
your stacks). .

» Locked stack changes: When a stack is locked and the menu bar is hidden on a card,
HyperStudio will ignore the keyboard commands for Move to beginning and end of stack, and
next-card, previous-card. This lets you control the user’s actions a little better in test stacks,
adventure games, eic.

IMPORTANT: It is now possible to create a stack which cannot be unlocked! 1f you

hide the menu bar on all cards but the last card, and then lock the stack and save it, AND there
is no button that specifically moved to that last card, you will not be able 1o get back to the
last card to ever unlock the stack again (or make changes). This is a "feature” for those wanting
1o create absolutely locked stacks, but you should use this option with care, and always keep
another unlocked copy of the stack as a backup.

= Usage tip: A stack can be locked wirthow using a password. All that is necessary is 10
check the box "Locked Stack” in the Preferences dialog box. A password need not be entered to
lock a stack. This will make it easier for other users of your stacks to unlock them to make
changes in those cases where this is not an issue for them. We've seen a number of stacks in
the public domain that are locked with a password where there is really no need to use one. You
should use password-locked stacks only in those cases where you absolutely do not want any
user to alter your stack. This might be the case for test stacks used by students, but we
encourage you to use this feature sparingly.

» Apple-S now is the keyboard equivalent for SAVE. It used to be for Save As...
'I'hiswi]]letyousavestacksinmndywimasinglekeypress.lfmesmk'nsbmndmwmﬂhm
not yet been given a name, pressing Apple-S will bring up the Save As dialog so you can name
the file,

« Show Invisible Buttons. Holding down the Apple- and Option-keys simultaneously will
display the invisible buttons on a screen. This is disabled if a stack is locked.

» "Local" directory application support. Siacks moved to new directories can launch
applications in the same directory with no button editing. HyperStudio 2.0 linked buttons to
applications with an absolute pathname, and, for example, moving Sound Shop to a hard disk
lost the connection 1o that program in the Home.Stack. In HyperStudio 2.1, buttons will find
applications at both their original location and the local directory, if present

« Modified PRODOS file. This is a special version of PRODOS (on the /HyperStudio

disk) that gives a little more usable memory on a ROM 03 Apple [IGS. It has no effect on a
ROM 01 machine. Move this file to your startup volume if you aren't using the /HyperStudio
disk.




* CLV (time-based or "Extended Play") laser disc support. This version of

HyperStudio now supports CLV laser discs. Note: The software interface for CLV discs is a
little more sensitive than the frame-based drivers, and may require that you use the START
button in the remote-control dialog box that comes up when you choose "Add a Video" (Objects
menu) or "Play a Video" (button action). The START button only needs to be used when you
first insert a new laser disc. The way to tell that everything is properly started and synchronized
18 o make sure that the little button 1o the right of the frame # indicator reads "Tm" (for
"Time"), rather than "Ch", "Fr", or a blank button.

The number register for CLV disks is in HR-MIN-SEC format. That is, a number valve of
02030 would mean O hours, 20 minutes, and 30 seconds. Since there can only be one hour of
video on a side of a laser dise, the first digit will always be "0". Entering a number like 00090
will ﬂm::v a corrected value of 000130 (that is, 90 seconds is converted to 1 minute, 30

Creating User Disks for Others

Although the HyperStudio program itself cannot be given o others, a way has been provided to
creale disks with your stacks that are independent of the original HyperStudio program. This is
done using an additional file, HS.Sys16, that is located on the HS.Art disk.

HS.Sys16 is a miniature version of HyperSmdio that has no editing functions, only the ability
to run stacks you've created. Disks for other Apple IIGS users are created by puiting this file
on a disk, along with your own stacks. The "User Disk"” you create this way can either be a
startable disk, and thus completely self-contained, or you can create disks with just the
HS.Sys16 file and your stacks. In this lauer case, the user would have to start up the computer
with a System Disk, or other startable disk, and then launch HS.Sysl6 from the Finder, or
other program launcher.

Remember, since any stack can branch to another stack, even on another diskette, it is not
necessary that all the stacks for your project fit on one disk. You could, for example, create a 2-
disk set with a startable disk with HS.Sys16 and your Home Stack on the first disk, and then

use a button (o link (o the stacks on the second disk. This is the way the /HyperStudio and
/HS.Demo disks are set up in the HyperStudio package,

File-Copy Instructions

The following instructions are for those familiar with copying files between disks. If you are
more comfortable with an automated process, skip ahead to the section titled "Installer
Instractions”. That section describes a utility that will automatically create User Disks for you.

» Startable User Disks: To create a disk with System files that will start up to your own
Home Stack, do the following:

1. Creaie a startable System disk with the file PRODOS and the System folder. You should
delete, if necessary, the files START and P8 from the System folder, along with any

Driver files (System/Drivers). You should also delete BASIC.System and
BASIC Launcher, if necessary, from the main directory.

2. Copy the file HS.Sys16 from the HS.Art disk to your new disk.
3. Copy your own Home.Stack 1o your new disk.
That's it! This will now give you a self-contained disk, that when started up, will go directly 10

your own Home.Stack. This disk can be distributed to others in accordance with the HS.Sys16
License Agreement.




* Non-Startable User Disks: If you do not require a startable disk, you need put only the
file HS.Sys16 on your disk, along with whatever stacks you wish.

IMPORTANT!! YOU MAY NOT, UNDER ANY
CIRCUMSTANCES, DISTRIBUTE COPIES OF THE
HYPERSTUDIO FILE. ONLY THE HS.SYS16 FILE MAY BE
LEGALLY COPIED UNDER THE PROVISIONS OF THE
HS.SYS16 DISTRIBUTION LICENSE.

In general, if you will be selling the disk with your stacks, this is considered "commercial use”
of the HS.5ys16 nn-time file, and a modest annual license fee must be paid to Roger Wagner
Publishing, Inc. If you are not selling your stacks, then no license fee is required. Non-
commercial use would include public domain stacks in user group libraries, stacks shared with
friends and family, and stacks created for non-commercial distribution in schools.

Installer Instructions

This section describes how to use the Installer utility, provided on the /HyperStudio disk. This
utility will amtomatically copy all the necessary files to create a User Disk for your own stacks.

You will also need the /System.Disk for GSOS version 5.0.2 or later, as
supplied with your Apple IIGS computer, and/or by your local dealer.

1. Start up your computer with the /System.Disk. This will eventually display the Finder.

2. Insert a blank disk. When prompted, format the disk as you would any data disk, and name
the disk User.Disk (or any other name you wish).

2a. If you have a disk that is already formatted that you are "recycling”, choose Erase Disk
from the Disk menu of the Finder after selecting the disk to be erased.

3. Insert the /HyperStudio disk, and launch the Installer program.

4, Click on the Disk button until you see your disk (User.Disk or 77?) identified at the top of
the window on the right of the screen.

5. Scroll down through the list on the left until you see the entry "Latest Sys. Files (No
Finder)". Select this by clicking with the mouse on the entry.

6. Click on the Install button at the top-center of the screen. As the installation process
proceeds, you will be prompted, if necessary, to insert the appropriate disks.

7. Again, use the Disk button to select your disk (User.Disk), and choose "User's Startable HS
Disk” as the Update Selection.

8. Click on the Install bution to begin the process. When finished, choose Quit to retumn to
the Finder.

You now have a disk that, when started up, will display a title screen, and go to a "dommy”
Home Stack. You may want to keep a backup copy of this disk to use as a siarting point for
other User Disks in the future.

Customizing the Disk

» Home Stack: The first thing you'll want to do is to replace the Home.Stack on the
User.Disk with your own Home.Stack. This can be done by running your own full-version of
HyperStdio, loading your Home.Stack, and then saving it to the User Disk. Other stacks may
be added as room allows. Depending on how many stacks are in your project, it may be
necessary 10 create a second disk, perhaps called User.Disk2, that contains just the additional
stacks that won't fit on the first disk. It is not necessary o put the System files or HS.Sysl6
on any other disk other than your first startup disk (User.Disk).

+ Startup Screen: The HyperStudio disk has a startup screen that is shown every time the
disk is started up. You can create the same effect on your own disks by using the Sight 'n
Sound utility (there's an icon for this the HyperStudio Home Card under "Applications”) to add
your own startup picture. On the HS.Art disk is a file named "User.Title.Scm” that you can use
as a starting point for your own startup screen, and customize this graphic for your own disk.

You can also add a startup sound to your User Disk using the Sight 'n Sound utility. Be aware
that a startable disk with System files doesn't have a lot of extra space on ii, and it may not be
possible to fit the System files, a large Home Stack, and a large sound file on the disk. This
may take a little experimenting to balance the use of the available space on a given disk to your
satisfaction.




Index

816/Paint ™
A

Actions

Add a Button

Add a Clip Art

Add a Graphic

Add an Object

Add a Sound

Add a Text Item
Add a Video
Advanced User
Alternate Answer
Alternate Home Cards
Animate

Another Card

Apple Menu
AppleWorks 2.1

An Library
Authoring
Aunio-activale buttons

B

Back
Background Info
Backing Up Disks
Baud Rate
Beagle Paint
Begin

Blinking Objects
Bring Forward
Browse (Hand)
Browser

Brush Shape
Buffer Status
Button

Button Actions
Button ID
Button Info

20

12
13, 14
42,48, 53

C

Card ID

Card Info

Catalog

Chapter Mode

Choose Printer

Clear

Clear Clipboard

Clipboard

Colors Menu

Connect to:
Another stack
Another card
An Application

Control Panel

Copy

Copy Card

Correct Answer

Creating Stacks

Current File

Custom Palette

Cut

Cut Card

D

Data Access Method
Delete Card
Demonstration Stacks
Digitized Sound
Digitizing Card

Other
Directories
Disable/Enable Cautions
Disk based

Data

Extended Objects

Text
Disktop Publishing
Display
Dithered Colors
Draw Filled

47
38
76
43

31, 65
65
30, 64

18, 39
22, 40

3,55
30, 64
31
46, 47
14, 15

50

30, 64
31

41, 55

E

Echo Delay

Edit an object

Edit Menu

Editor Stams

Edit Tool

Electrical Interference
Embedded Data

End

Eniering Text Direcily
Erase

Erase Background
Eraser

Extended Commands
Extended Objects

F

Fade Up & Down
Fans

File Menu

File Usage

Fill

Filter

Find

Finder, The

First Card

Frame number
Frechand Shape
Full Screen Video

G

Graphics,
640 Mode
320 Mode
Graphic Info

H

Hard Disk Installation
Hide Items
Hide Menu

58, 60, 71
33

30, 63

71

30, 33

81

52

42

65
31, 34
35
12,45

26, 62

45
38

Home
Home Stack
Home Card

Adding a stack 1o
[HS.An
HS.Demo
HS.Test.Results
HS Xcmd
Hypermedia
MyperSwdio disk

Installation
Alternate Technigue
Intro Stack
Invisible Bution
Item Info

K

Keep button
Key Color

L
Laser Disc Player
Lasso

Layer

Line Size

Line Tool

Live Record
Load Background
Local Data

Lock Stack

M

Magnifying Glass
Maximum Memory
Memory Status
Microphone
Microphone Technigue
MIDI music files

32

10, 23

10

10

38, 46

45
10

10,
18,
33,

41

21,

51
35
41

16,

55
53

37
70

83
85

11
20
38

30, 35

27




Modem Port
Monitor

Move Menu
Moving Objects
Multiple choice

N

New

New Card
New Stack
Mext Card

0

Objects Menu
Open

Open Stack
Options Menu
Other Microphones
Output Quality
Owal

P

Page Setup

Paintbrush

Paint Tools

PaintWorks Gold™

Password

Paste

Pause

Pencil

Picture Tool

Pioneer 2200,
4200, or 8000

Play

Playback Rate

Playback Speed

Playback Volume

Play Clipboard

Play part of sample

Play Video

Play Volume

42

32
79
47

62

31,54
15,27
18, 32, 40

38
62
27
51
83

36

Play Sound
Polygon
Preferences

Previous Card
Print

Q

Quit
Quit HyperStudio

R

Rate

Record

Record Modes
Record Threshold
Rectangle

Redraw

Repeat

Repeat Count
Reposition an object
Reverse

Revert

Rounded Rectangle

S

Save

Save As

Saving A Stack

Save Screen

Selected Record
Selector Tool

Send Behind

Set Background Color
Set Text Color
Settings Menu

Show Card Number
Sight 'n Sound
Signal to Noise Ratio
Slide Show

SNS.320

46
57
68
58,61, 71
36

67
46
58, 60, 71
33
67
63
36

SNS.640
Sound
Sound Menu
Sounds, other formals
Sound Sample
Sound Shop
Sound Tool
Special Features Note
Spraypaini Brush
Stack Ideas
Stack Info
Stacks

Other sources of
Standard File Interface
Star/Reject
Startup Defaults
Startup Picture
Starup Removal
Startup Sound
Status Displays
Step
Stereo
Stop
Swp And Play
Stutter
System Beep
System Requirements

T

Technical Support
Test

Text

Text Info
Text Style
Text tool
Timed Test
Tools

Tools Menu
TouchWindow
Transition

72
43, 81
68

B4

59

10, 41, 57
3

9

36

75

9

11

13

26

43

69

T4

73

72

70
42,43
43

57

68

67

73

3

42, 46

38
51
21,34
47
65
33

18, 40

Undo
"

Video Overlay Card
Video Overlay Demo
Volume

Volume Control

X

XCMDS

4]
12
35, 60
b

12, 45







